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Theatre Management System V4 

A comprehensive solution for centralized cineplex management 

 
GDC Technology’s Theatre Management System (TMS) is a powerful tool that  

offers a centralized point of control for an entire cineplex. Optimization 

of your digital system is made easy with the TMS, which allows users  

to automate and streamline your entire cinema operation. 
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Thank you for purchasing GDC Theatre Management System from GDC Technology Ltd. 

To ensure proper operation and to maximize the TMS’s value, please allot a few minutes to review this User manual. It will 

guide you through all the features and benefits of the TMS. 

 

 

ABOUT THIS MANUAL 

 
This TMS user manual is intended to provide the reader with an overview of the main features and benefits of the 

Theatre Management System (TMS). For more information, please refer to the GDC Technology website (www.gdc-

tech.com) or contact one of our offices.  

 

 

COPYRIGHT NOTICE 

 
Copyright © 2022 by GDC Technology Ltd. All Rights Reserved. 

 

No part of this manual may be copied or distributed, transmitted, transcribed, stored in a retrieval system, or translated 

into any human or computer language, in a form or by any means, electronic, mechanical, photocopying, recording, 

magnetic, optical, manual or otherwise, or disclosed to third parties without prior written permission of GDC 

Technology Ltd.  

 

 

MANUAL DISCLAIMER 
 

This current version is made with version v4.3.14392 and there might be slight differences depending on the software 

version the client is running. The contents, features and specifications stated in this manual are subject to change 

without notice due to continuous product development and improvements. In no other event shall GDC Technology 

Limited be liable for any loss of profit or any other commercial damages, including but not limited to special, 

consequential, or other damages. 

http://www.gdc-tech.com/
http://www.gdc-tech.com/
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1.  INTRODUCTION 

The Theatre Management System TMS-2000 is a state-of-the-art powerful tool for managing servers in cinema 

multiplex via network connection. The purpose of this document is to provide guidance on how to use the TMS. 

 

1.1.  Features 

• Centrally controls servers inside theatre. 

• Communicates with servers over local area network. 

• Theatre-wide server, content, key and playlist information aggregation and management. 

• Servers can be organized into categories for easy management. 

• Transfers content and security keys to servers. 

• Intelligent source location selection for content transfer. 

• Scheduled content transfer. 

• Content search by name. 

• Supports single clip or whole package content transfer from one location to another. 

• Supports live-play source management and playback control. 

• Supports server initialization and server content transfer. 

• Creates playlists and schedules shows to be played on the servers up to weeks and even longer time  

in advance. 

• Automation cues can be specified and inserted into playlists. 

• Schedules can be easily duplicated in other days, and cancelled etc. 

• Supports different show play types. 

• Timeline style show schedule display. 

• POS data integration is supported and schedules can be created based on POS show time automatically. 

• Semi-Automated show scheduling by TMS Template System. 

• Real-time monitoring of screen playback status. 

• Real-time monitoring of show schedule. 

• Remotely control of playback. 

• Retrieves real-time information on the playback status of the server. 

• Retrieves playback logs from servers. 

• Information such as software and OS version, available disk space, etc. can be viewed at a glance. 

• Projector connected to the server via Ethernet can be remotely controlled. 
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• Mainstream theatrical equipment management and control. 

• Event notification by email. 

• TMS system data backup and restoration. 

• Reverse content transfer from storage in playback server. 

• Multiple language GUI. 

• Content Verifier. 

• Emergency Cues. 

• Automatic Detection of new Content through Content Watcher. 

• Automatic ingestion of KDM from an email source. 

• Support Comprehensive Automation Control with Auto-PMA and Auto-QMS. 

• Monitor cinema operations remotely in real-time using TmsAware™ App. 

 

 

 

1.2.  Version 

This document complies with GDC Theatre Management System version number 4.3.119841. 
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2.  TMS GUI OVERVIEW 

When launching and logging into the GDC TMS software, the TMS graphical user interface (GUI) will be loaded to 

the default tab which is the Monitoring tab (as shown below). This GUI consists of a series of menus, tabs and 

subtabs that allow access to the various functions of the TMS. 

 

 

 

 



3. MONITORING TAB 
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3.  MONITORING TAB 

By clicking the MONITORING tab, the monitoring interface will be loaded as below. This is the default tab/view when 

logging into the TMS software.  

 

 

 

1  This section shows the icons for Monitoring, Scheduler, Content and Screen tabs which contain different 

functions in the TMS.  Click the icon to switch quickly to another tab. 

 

2  This section shows all of the managed screens and the status of their connection to the TMS server. 

The icon shows the connection status of the screen (Online: Blue icon; Offline: Dark icon. ). 

           

 

 

3 4 

1 

5 

2 

6 



3. MONITORING TAB 

 
  

 

13th April 2022 -14- User Manual for Theatre Management System TMS-2000  

Document Version 4.3.1.02 

 

When the mouse cursor is on top of the screen icon, a pop-up window will remind the user to right-click 

to access more options. By right-clicking it, there are options to wake up the server, view the screen 

server GUI, download server certification, and connect/disconnect to the screen. Use the [Wake Up] 

button to power up a server. Check that the power plug and the network ports of the server are 

connected, do not power on the server, click [Wake Up] button to power up the server. Wake Up function 

is only available for certain GDC servers, the [Wake Up] button is not available if the server does not 

support this function. 

 

 

The green spot indicates that the server has been powered up and is able to be ping from network. 

When [View GUI] is selected, a VNC remote session to the server will be initiated and a pop-up dialog 

will prompt the user to input a password (please check with server operation manual for the password 

setting). After correct password is entered, the selected server UI will be displayed, allowing direct 

access to control that screen as if the user is at the server itself. 

In case of GDC SR and SRC series of servers, the [View GUI] is replaced by [View Web GUI] as shown 

in the image below. When [View Web GUI] is selected, TMS will initiate a web-based remote session 

with the playback server by opening a web page of the default browser set on the TMS server and 

prompting the user to input the username and password. After the correct credentials are entered, the 

selected server’s WebUI will be displayed, allowing the user to control the playback server. 

 

 

 

When [Server Certificate] is selected, TMS will download the server certifcate of the selected screen 

to the TMS machine. User will be prompted to specify where to save the server certificate of the selected 

screen. 

When [Connect to Screen] is selected, the connection between the TMS and the server will be 

established, allowing the TMS to interface with that server. This is also the default behavior when left 

clicking the screen icon directly.   
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When [Disconnect from Screen] is selected, the connection between the TMS and the server will be 

disconnected. 

Other connection status include: Error, Playing, Stopped, Paused and Offline. In case of a playback 

error, the error message will be displayed according to server status when the mouse cursor is on 

[Error] icon as seen below. 

 

 

 

Note: Connection establishment time varies depending on the amount of data in each individual server 

to be updated and the network status. The first time connection establishment will be longer as all the 

data need to be retrieved and synchronized from scratch.  

3  This section provides the Server Playlist and content details. When a screen is connected to the TMS, 

this section will indicate the name of the currently loaded show playlist, the elapsed and remaining time 

during playback, the current clip title, current clip number, the total number of clips in the SPL and update 

time (playback server time). The next show and start time will also be shown at the column below. 

 

4  
 

TMS-2000 also has the option to display critical timecodes on the Monitoring page. The following 

critical timecode indicators are displayed: 

 

• Start of Feature 

• Intermission Start 

• Intermission End 

• Credits 

The timecodes are marked on the playlist progress bar and are also displayed as a countdown to the 

next critical marker, as shown in the below picture. 

 

The timecode indicator feature can be enabled by checking the [Enable Timecodes Indicator] option 

from the Tools → Preferences → POS → Auto-SPL 
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5  For server remote control buttons, the keys are Play, Pause, Stop, Fast Forward (by 60 seconds for 

each click or to the end of current clip), Rewind (by 60 seconds for each click or to the beginning of the 

clip), Next (to next clip) and Previous (to previous clip). 

 

Note: To move forward or backward, the playback status must be Paused or Stopped. 

Besides controlling the server playback functions, TMS can also control the automation cues in the 

server, load the SPL available in the server for playback, set the sound volume level and sound channel 

type in the sound processor and control the projector actions include open dowser, close dowser, on 

lamp, off lamp and macros switching. 

 

 

All the buttons are locked by default by the Lock icon.  When the buttons are locked, they are greyed 

out and unable to click. It is to prevent user from accidentally pressing the control buttons, and when 

the  Lock icon is pressed, the icon will be changed to unlocked mode  for 10 seconds, and all the 

available buttons will be in blue color and user can click them for operations. 

 

Click [Execute Automation Labels] icon  to load all the automation cues available in the server 

and automation device list. 

For Automation Cue, the cues must first be setup and defined in the server. Select a cue from the 

Automation Cue list, then click [Execute] button to load the cue. 
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For Automation Device List, select a device from the Automation Device List, select label and action to 

its corresponding dropdown list, then click [Execute] button. 

 

 

 

Click [Load SPL] icon   to select and load the SPL for playback in the server. The SPL details will 

be shown when user selects and highlights it. Click [Load SPL] button to load selected SPL.  

User can also opt to unload currently loaded SPL in the playback server clicking [Unload SPL] button 

in the SPL List window. 

 

 

For Sound Processor and Projector automation control, both devices must first be defined and mapped 

to screens in TMS, else the icons will be grey and the devices are unavailable for monitoring and control. 

Click [Sound Processor] icon , user can mute/unmute, adjust the volume, and select the correct 

channels for sound output. 
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For Projector Control, click [Projector] icon  to control projector functions. 

 

For Projector Selection, when there are more than one projectors in a hall, user can click [Projector 

Selection] icon to select the other projector for operation. 

 

For Power/Standby Mode, this option is only available for Christie and NEC projectors. When the 

projectors are in standby mode, user can click the icon to change it from offline/standby mode   to 

power mode and vice versa. From projector information on the right, user can check whether the 

projector is in standby or power mode.  

 

For Lamp mode, user can click [Lamp] icon  to toggle the lamp to be on or off. When Lamp is on, the 

icon will turn to yellow . 

For Dowser control, user can click the icon to open or close the dowser. When Dowser is open, the icon 

will change from   to . 

6  Screen information on projector, audio and server can be viewed on monitoring tab. Information such 

as projector‘s online and connection status, lamp running hours, server serial number, software and OS 

version, percentage of used OS and data disk space, etc. can be viewed at a glance when a screen is 

connected.  
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When mouse cursor is on the projector icon, it will show projector information in text. 

 

7  At the bottom of the monitoring tab, the status of each screen is displayed on the left of each screen.  

 

On the right, it indicates the total size remaining in Theatre_Store data storage, the Notification viewer, 

Content verifier viewer, Ingest status viewer, and Transfer Display viewer. 

 

Click [Notification viewer] icon  and a pop-up window will show all the notifications received from 

the servers. System event alerts displayed in the Notifications can be configured in the server UI. 

 

 

User can verify contents in Theatre_Store data storage in Content Tab.  After verifying contents, click 

 to display the Content Verifier window to check verification status. The digit on the right shows 

the total number of tasks and the digit on the left shows the total number of complete tasks. 
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User can ingest contents into Theatre_Store by using File -> Ingest DCP/KDM.  Once ingested, user 

can click  icon to check the ingestion status. The digit on the right indicates the total number of 

ingestion and the digit on the left indicates the total number of completed ingestion. 

 

 

 

Note: Completed ingest tasks older than 5 days will automatically be removed in the Import Display 

window. 
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User can transfer contents from one server to another server in the Contents tab.  Once transfer is done, 

user can click the  icon to check the transfer status. The digit on the right indicates the total 

number of transfers and the digit on the left indicates the total number of complete transfer. 

 

 

 

Note: Completed transfer tasks older than 7 days will automatically be removed in the Transfer Display 

window. 
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4.  SCREEN TAB 

At SCREEN tab, user can add and map devices to Screen. Once a device has been added to Screen, user can 

check device information, monitor and control device at Monitoring Tab. By clicking SCREEN tab, user can see the 

Device tab at the top of the UI window. 

 

 

 

1  Click [Add Devices] to add and map devices to Screen. Click [Projector]. 

 

 

Enter the Projector Model, ID, Name, IP and define the lamp warranty hours and select the Screen to be linked to. When 

the lamp hour is set, if the total running hours exceed this value, TMS will send a notification to inform user. 

 

 

 

 

 

2 

1 

3 
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After entering the details, click [OK].  In the left panel of Screen tab, select Hall 1 in the Screen list to check if Projector 

added has been mapped as device to Hall 1. 

 

 

 

To add Dolby CP750 sound processor, click [Add Devices], followed by [Sound Processor]. 
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Click [OK]. In the left panel of Screen tab, select Hall 1 in the Screen list to check if Sound Processor added has been 

mapped as device to Hall 1. 

 

 

Click monitoring tab to check that both Projector and Audio information are being shown. 

 

 

Besides monitoring both Projector and Audio devices, user can change the settings by clicking the Projector and Sound 

Processor icons. 

Click the Sound Processor icon to change the volume and sound channel. 

 

 

Click the Projector icon to on/off lamp, open/close dowser and switch the macro type. 
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To add LSS100 analyzer, click [Add Devices], followed by [Analyzer]. 

 

 

Click [OK]. In the left panel of Screen tab, select Hall 1 in the Screen list to check if LSS100 added has been mapped as 

device to Hall 1. 

 

 

 

Click Quality tab to check that analyzer is added in the list. 
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To add ACS-2800 automation device, click  [Add Devices], followed by [Automation]. 

 

 

Channels available for ACS-2800 can be configured by clicking [Manage Channel] button. In the Manage Channel window, 

user can select which channels to enable, rename its labels, and configure the channel‘s action. 

 

 

 

Click [OK]. In the left panel of Screen tab, select Hall 1 in the Screen list to check if ACS-2800 has been mapped as  

device to Hall 1. 

 

Click MONITORING tab then click Execute Automation Labels icon to check that automation device is added in the screen‘s 
Automation Device List.  
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To add PMA-2000 automation device, click [Add Devices], followed by [Automation]. 

 

 

 

Channels available for PMA-2000 can be configured by clicking [Manage Channel] button. In the Manage Channel window, 

user can select which channels to enable and rename its labels by selecting a channel in the list, then click [Rename] 

button. Enter the desired new label for the channel then click [Save] button. 

 

 

 

Click [OK] to save the configuration of the new automation device. In the left panel of Screen tab, select Hall 1 in the Screen 

list to check if PMA-2000 has been mapped as device to Hall 1.  

Click MONITORING tab, then click Execute Automation Labels icon to check that Automation Management window will 

include PMA-2000 Controls tab. 
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In the PMA-2000 Controls tab, toggle the channel by clicking the switch. Green switch will indicate that the channel is 

open while the red switch will indicate that it is close. The vertical line above each channel switch will indicate if there is a 

power coming in its designated channel or not. 

Cinema Operating Times can be configured by clicking [Tools], [Preferences], [General] then changing the [Start Time] 

and [End Time] fields. 

2  Devices can be added to both online and offline Screens. 

3  After linking devices to Screen, it will be listed in the Device table of Screen tab. 
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4.1.  Adding TMS Device Proxy [CP650] 

To add CP650 sound processor, user first has to add the CP650 settings into TMS Device Proxy. Click [Tools], 

[Preferences], 

 

 

Click [Device Proxy] icon and click [Add], from Add Entry pop-up window, input values for the following fields:  

- Destunation IP [IP address of the CP650 sound processor] 

- Local Port  [port for the device proxy of CP650 in TMS machine] 

- Destination Port [port of the CP650 sound processor] 

- Comment 

Click [OK] to save the entry. 

 

 

 

The entry will be saved as shown below.  Click the cross at top right corner to close the window. 
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At Screen tab, click [Add Devices], [Sound Processor]. Input the ID, Name, IP [IP address of the CP650 sound 

processor] and the Port [the destination port entered above], select the Screen in the Link to dropdown menu and 

click [OK]. 
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5.  CONTENT TAB 

The CONTENT tab is designed to allow user to create a show playlist (SPL) in the sub-tab CREATE and manage 

content in the sub-tab MANAGE. User can browse aggregated content information such as name, duration, KDM 

status and storage location, etc. An alert will be highlighted in the user interface under the Validity column when the 

KDM expiration date falls within a preset threshold. User can build a theatre wide show playlist based on aggregated 

content from throughout the entire theater. Show playlists can be sent to any connected screens and the content will 

also be transferred even if it is not present on the screen, which the playlist is transferred to.  User can use the 

[Search] button to search for contents.  The other buttons are Library, Backup Storage, Update. 

 

 

 

5.1.  Manage Content 

5.1.1.  Aggregation and Display 

To manage contents, click [MANAGE] to access the sub-tab as seen below. 
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Movie content and playlists available on the TMS and the screens in the theatre can be aggregated and managed 

in this area. They can be browsed by selecting location and category combinations. The location/view can be 

filtered further to only the TMS store or one individual screen, but defaults to All Media in Theatre. Contents are 

listed into the following categories: CPL, DCP, SPL, and KDM.  

While its Composition Playlist (CPL) is filtered into the following types: features, trailers, advertisements, policies, 

teaser, test, rating, and others. The [Update] button  allows user to retrieve the latest data from connected 

screens, in case any recent changes were made at the server itself. The time required to perform an update 

increases as the amount of data being pulled increases.  

When the [all CPL] sub-tab is selected, all types of CPLs will be displayed; Information includes the CPL name, 

duration, size, format, validity, etc. For more convenient browsing, CPLs are displayed in different categories 

based on the composition type. 

The display area on the right side will show more detailed information about the selected CPL and where it 

is located. 

 

The category tab [DCP] will show  the user the DCP information, which includes name, UUID, issue date and 

storage location. 
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The category tab [SPL] contains show playlists across the theatre. The location and details of the selected SPL 

are displayed on the right side. By selecting the [Detail...] button, user can view the CPL and right-click the CPL, 

then select [Display All Cue] to show cue label items or intermission in the playlist. 

By right-clicking any selected CPL, DCP and SPL, user can transfer or delete content.  More detailed information 

on these features are available later in this chapter. 

 

 

The category tab [KDM] contains a list of content security keys accross the theatre. It provides information such 

as the KDM status, Content Name, KDM ID, Valid Before date, and Valid After date. The following icons indicates 

the KDM’s status: 

•  - indicates that the KDM is valid 

•  - indicates that the KDM is expired 

•  - indicates that the KDM’s validity is in future date 

•  - indicates that the KDM’s content is not available in Theatre_Store or any of the servers registered in 
TMS when it was ingested. 
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More details such as KDM’s destination screen and if it was transferred to its corresponding server can be viewed 
Theatre_Store. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



5. CONTENT TAB 

 
  

 

13th April 2022 -35- User Manual for Theatre Management System TMS-2000  

Document Version 4.3.1.02 

 

5.1.2.  Data and Transfer 

Data and Transfer allows user to define the location where the content is being stored in TMS, select Content 

Transfer Source location and define the Transfer Source Settings. 

 

 

 

For Data Directory, content location can be either on TMS PC itself or a network mapped folder. Default 

Theatre_Store directory is C:\Program Files (x86)\GDC\TMS\data\data\repository. 

When [Enable Auto Content Transfer] checkbox is ticked, TMS will check every 2 hours the scheduled 

SPLs. If there are missing  contents or KDMs that are included in the scheduled SPLs, TMS will do an 

automatic content transfer to its designated screens. 
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5.1.3.  Ingest DCP/KDM through Local Machine 

Click menu [Tools], [Ingest DCP/KDM], an user interface “DCP/KDM Import” window will pop up to import movie 
content or KDMs from one location on any attached drive to the TMS machine (It can be an external hard disk or 

mapped network drive network) into the TMS storage.  

 

 

 

Select the individual drive and folder button, user can browse a hard disk drive directory and select the folder 

which contains content packages and KDMs to be imported into the TMS storage, Theatre_Store.  When a content 

is already ingested, it will be greyed out and is unable to be selected for import. 

 

 

 

For Ingesting DCPs, the TMS will automatically detect the content package information in the selected folder. 

Composition clips of the DCP will be displayed and selected automatically for further import. 

For Ingesting KDMs, the TMS will automatically detect which servers the KDMs belong to. Automatic transfer of 

KDM to its designated screens after successful ingestion to TMS Theatre_Store can be enabled in Preferences, 

click [Tools], [Preferences], [Data and Transfer], tick [Automatic KDM transfer after ingest] checkbox, then 

restart TMS for changes to be effective. 
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If a server is disconnected from TMS and KDM transfer after ingest is enabled, TMS will not send the KDM to the 

server until it is connected. Multiple KDM files can be selected at the same time. 

 

 

 

User can check the total space available in the TMS Theatre_Store data storage on the right of the window which 

indicates the free space before ingesting content into it. In the Packages list, select the clips to import to the TMS 

and click [Ingest Checked]. “Ingesting” will be shown below the Ingest column. 

Select [Close] to close the ingest window. To check the ingest progress status, check on [View], [Ingest]. 
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An Import Display window will pop up, it will show whether the content is successfully ingested. Alternatively, user 

can click the bottom right arrow  and the same Import Display window will pop up. 

 

 

 

To check the transfer progress status of DCPs and KDMs, check on the menu [View], [Transfer]. A transfer 

content window will pop up, it will show whether the content is successfully ingested. Alternatively, user can click 

the bottom right arrow  and the same Transfer Display window will pop up. 
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5.1.4.  Ingest DCP/KDM through FTP 

User can transfer contents from servers to TMS Theatre_Store by using the FTP ingest. To import content using 

FTP into Theatre_Store, click the FTP tab, click [Add] to add new FTP source. 

 

 

 

Enter the details of the FTP source, and click [Test] to check if the connection is sucessful, and click [OK]. 

 

 

 

A new entry will be shown in the FTP column, click [Connect] to connect to Hall 1 using FTP.  As Hall 1 is 

connected, TMS will load all DCP listed in the server. By ticking the [Enable Verification] checkbox beside the 

[Connect] button, TMS will verify whether the contents listed from the FTP server is valid or not. If the content is 

invalid, it will be grayed out and user will not be able to select the content from the list. 
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Click [Ingest Checked] to ingest all contents in Hall 1 to TMS Theatre_Store.  At the bottom right of the TMS 

User Interface, there will be an icon that shows the ingestion progress ,which means that TMS is 

currently processing the 56th tasks out of a total of 194 tasks. Double-click the arrow to check the ingestion 

progress. 
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5.1.5.  Ingest SPL 

Click menu [File], [Ingest SPL]. 

 

 

Locate the of SPL files in the disk drive. Select the SPL file and press [Open]. Multiple SPL files can be 

selected at the same time. 

 

 

 

To check the ingest progress status of the SPL, check [View], [Ingest]. 
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An Import Display window will pop up, it will show whether the content is successfully ingested. Alternatively, 

user can click the bottom right arrow  and the same Import Display window will pop up. 
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5.1.6.  Ingest Template 

The [Ingest Template] option allows users to ingest Templates and Content Packs into the TMS. To do so, 

click menu [File], [Ingest Template]. 

 

 

 

Locate the Template files in the disk drive. Select the Template file(s) to be ingested and press [Open]. 

Multiple Template files can be selected for ingestion at the same time. 

 

 

 

An Import Display window will pop up and show whether the Templates were successfully ingested. 

Alternatively, user can click the bottom right arrow  and the same Import Display window will pop up. 
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Once ingested successfully, the Templates will be available in the Template System Editor as seen in the  

image below. 
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5.1.7.  Ingest DCP from Satellite 

Ingest DCP from Satellite can be enabled in Preferences, click [Tools], [Preferences], [General], tick 

[Enable Ingest DCP by Satellite] checkbox, then click [OK] for changes to be effective. 

 

 

Click menu [File], [Ingest DCP from Satellite] option will be availble to user. 

 

  

 

Enter the details of the satellite’s DCP host, then click [Connect]. TMS will load all DCP available in the satellite. 
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Click [Ingest Checked] to ingest all contents from satellite. Select [Close] to close the ingest window. To check 

the ingest progress status, check [View], [Ingest]. 
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5.1.8.  Content Scan 

Content Scan allows user to do a batch import of contents to TMS without the need of ingesting the contents one 

by one. User can copy and paste all the contents in the Scan Directory (C:\Program Files 

(x86)\GDC\TMS\data\data\repository\scan). Check  [Tools], [Content Scan]. 

 

 

 

The Scanned Contents window will display the Contents Ready for Import tab with the list of the contents that are 

ready for import. Click [Refresh] button to update the information in the list. 

 

 

 

Select the contents you want to import, then click [Import Content] button. Scanned Contents window will display 

the Contents Successfully Imported tab with the list of the contents imported in TMS. 
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5.1.9.  Content Transfer 

The TMS can initialize the content transfer from the TMS to the screens, from the screens to the TMS and from 

one screen to another. 

 

Note: To support content transfer between screens, make sure the data channel and file transfer service are 

ready for use. 

 

 

For transferring CPLs and DCPs; select single or multiple items from the movie content list to transfer to single 

or multiple screens simutanuously. The source location can be the TMS or the screen storage. Right-click the 

content and choose [Transfer CPL(s)] (or [Transfer DCP(s)] for DCP), a window will pop up as seen below. The 

left side of the window displays the content to be transferred and the right side of the window lists the connected 

screens that user can send the content to. Select the screens to send the content to and then press [OK]. The 

TMS will begin transferring the content to all selected screens. 
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For transferring SPLs, click SPL tab to view the list of available SPLs. 

 

 

 

Right-click the show playlist and choose [Send to...], a window will pop up as seen below. The left side of the 

window lists the connected screens which user can send the playlist to and the right side of the window displays 

the content and information of the SPL.  When [Send SPL with needed content(s)] checkbox is ticked, TMS will 

locate all the contents in the SPL from all available sources and send them to the designated screens together 

with its SPL. 

Select the screens to send the SPL to and then press [Send]. The TMS will begin transferring the SPL and its 

content to all selected screens. 

 

 

 

User can also opt to send the SPL only with its contents,  untick [Send SPL with needed content(s)] checkbox 

option and then press [Send]. TMS will send only the SPL to all selected screens. 
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For KDMs not yet transferred to its destination server, go to KDM tab of Theatre_Store to view the list of 

KDMs available. Transferred? column will indicate whether the KDMs are transferred or not. Right-click a KDM 

where Transferred status is ‘No’ and choose [Send]. 

 

 

 

To view the transfer status, click the  button located at the right bottom corner of the user interface. Transfer 

tasks are grouped by their destination screen name. Destination, type, title, schedule time, status, and remarks 

will be displayed and updated regularly. The transfer status can be: Queueing, Progressing, Done, Exception. 

For transfers in progress, the percentage of transfer completion is shown. The system will periodically update the 

transfer progress.   
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If a transfer fails, reason for the failure will be displayed in the Remark column if available. To cancel an existing 

transfer or to remove a completed transfer, right-click the transfer in progress, then select [Remove all selected]. 

 

  

 

Completed transfer tasks can be removed by type such as SPL,PKL, CPL, SCH, and KDM. For example, user 

want to remove completed schedule tasks, right-clickthe transfer in progress, select [Remove specific tasks], 

then click [Remove completed SCH] from the list. 

 

 

 

 

 

 

 

 

 

 



5. CONTENT TAB 

 
  

 

13th April 2022 -53- User Manual for Theatre Management System TMS-2000  

Document Version 4.3.1.02 

 

5.1.10.  Scheduled Transfer 

Scheduled Transfer allows contents transfer to be scheduled at a later designated time. It is useful when the 

server is in playback mode, and user can schedule the date and time for the transfer to take place after movie 

playback is complete or when the server is in idle status. Users have an option to schedule a transfer by 

Preference Time or by selecting a Date and Time of the schedule. 

To schedule a transfer by Preference Time, select [Preference time (HH:MM)] radio button, and click [OK] 

button. In the screenshot below, transfers will be executed every day at 01:00. 

 

 

 

Preference time for schedule can be configured, click [Tools], [Preferences], [Data and Transfer]; enter the 

[Transfer Schedule Preference Time] under the Transfer Settings section, then click [OK] button. In the example 

below, preference time will change to 02:30 and scheduled transfer will be executed every day at 02:30. 

 

  

 

Users can also schedule a transfer by selecting a Date and Time of the schedule; select [Date/Time] radio 

button to enable the date and time fields. Select the date in the calendar lookup and set time, and click [OK] 

button. Transfer will be executed on the date and time selected. 
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To view the transfer status, click the  button located at the right bottom corner of the user interface. 

Scheduled transfers will be queued in the list of its designated destination servers and the scheduled date 

and time of the transfer will also be displayed. 
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5.1.11.  Content Verification 

After complete ingestion of Contents into TMS data storage, Theatre_Store, user can do a Content Verification 

check to ensure that all the ingested files are not corrupted.  Right-click the selected content, select [Verify] or 

[Quick Verify]. When user selects [Quick Verify], it will only check that all required files are present.  When 

[Verify] is selected, the data integrity of the files are also being checked.  

 

 

 

When verification process is complete, a pop-up window will show the result. 
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Automatic verification of contents after successful ingestion to TMS can be enabled in Preferences, click [Tools], 

[Preferences], [Data and Transfer]; tick [Autoverify Content] checkbox, then restart TMS for changes to be 

effective. 
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5.1.12.   Delete CPLs, DCPs and KDMs 

Contents and KDMs can be removed from both the TMS storage and from each individual screen. 

To Delete CPLs/DCPs, right-click the item in the content list and choose [Delete Content]. 

 

 

 

From the pop-up window, select the locations you wouldlike to remove from the content and click [OK]. 

 

 

 

To Delete KDMs, click the KDM tab to view the list of KDMs available. Right-click the KDMs in the list and choose 

[Delete...]. The items will be removed from the selected screens. 
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5.1.13.  Lock / Unlock Content 

 

TMS also allows the user to lock content. The Lock Content feature allows the user to select certain CPLs 

which should not be considered for deletion, during the Auto-SPL housekeeping activity. 

To lock a particular CPL, go to CPL tab to view the list of CPLs available. Right-click the CPL in the list and choose 

the [Lock Content]. 

 

 

 

A pop-up window will be shown. Here, user can select the locations from which the selected CPL should not be 

purged, when housekeeping is carried out by the TMS. 
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Once done, click on the [OK] button. Notice that a lock icon  is now displayed against these cinema screens 

for the selected content, under the additional information section. 

 

 

 

Additionally, user can also refer to the Lock status column to get an overview of locked content. 

 

 

Similarly, user can unlock a particular locked CPL, by right-clicking on it and choosing the [Unlock Content] option. 
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5.1.14.   Manage CPL Skipping 

Skipping duration from clip‘s start time can be configured on CPLs in the Content tab, this feature allows cinemas 
to skip unwanted parts of the featured CPL and directly play the actual movie of the CPL. To configure skipping 

duration, go to CPL tab to view the list of CPLs available. Right-click the CPLs in the list and choose [Manage 

skipping duration].  

 

 

 

CPL skipping dialog prompt is displayed, enter value in the Skipping duration field, then click [OK] button 

to configure the value of skipping of the CPL selected. 

 

 

The scissors icon  will indicate that a CPL has a configured skipping duration time. 
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Note: CPL with skipping duration can only be used for servers that support this feature. The option to enable this 

feature is available at the time of adding a server in TMS. The CPL Skipping option will get enabled only if a 

particular server Type supports that feature. 

The images below show two different server types, where one supports CPL Skipping and the other does not. 
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5.2.  Show Playlist 

5.2.1.  Create Show Playlist 

To create Show Playlist, click  and select on CREATE to enter this sub-tab as seen below. 

 

 

 

Click [New SPL] in the menu button of the SPL Editor to create a show playlist (SPL). 

 

Specify a name for the SPL.  

Select the SPL category either ‘Normal SPL‘ or ‘Smart SPL‘. 

The main difference between a Normal SPL and a Smart SPL is, Smart SPLs allow users to add TMS Macros 

instead of adding macros from the playback servers while programming the SPL. 
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Before programming a Smart SPL, please ensure that the TMS Macros are mapped to the respective macros 

from the playback servers, as explained in section 8.24 (‘Macro Mapping‘). While transferring a Smart SPL to the 

target playback server, TMS will then convert the Smart SPL into a normal SPL (with the target server's macros). 

 

Smart SPLs are displayed separately under the ‘Smart SPL‘ tab of TMS‘s Content Manager, whereas all normal 

SPLs are displayed under the SPL tab. 

 

 

 

New SPL information will be displayed in the SPL information area. Add a CPL into a SPL by selecting the CPL(s) 

from the list on the top by the “Drag & Drop” method in the UI. A CPL from any location can be added to the SPL. 

User can use the “Drag & Drop” buttons to adjust the order of content in the playlist. To remove a CPL from the 

list, highlight and click [Delete CPLs] button. 

After the SPL is assembled, choose [Save SPL] and then [Exit Editor] from the menu button [SPL 

Editor]. The new SPL will appear in the sub-tab SPL in the media display area. 

 

 

 

The duration column indicates the total duration of all the contents in the SPL and the KDM Status Column 

indicates that there are KDMs present in the contents in the SPL. 
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 Create Show Playlist with Automation Cues 

In the SPL Editor list, automation cues can be added to any CPL by right-clicking on the content and click [Add 

Cues]. 

 

 

 

After clicking [Add Cue], the Retrieve MetaData window will pop up for adding cue labels, select and click the 

checkbox for the available cue labels from any of the selected connected screens then click [OK]. 

 

 

The Configure Metadata Point window will pop up. Cue labels are shown in the automation cue labels 

drop down menu. Add a cue label to a point in time based on the frame number or the time point value 

with the [Add Cue] button.  

The [Time]/[Frame] button can be used for toggling between the time and frame entry modes. To remove 

cue label, select a cue in the list then click [Delete Cue] button. 
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An arrow facing down will indicate that the content in the SPL editor list contains automation cues. 

 

 

 

 Create Show Playlist with ‘Black’ 

To add DC server black content to a show playlist, click [Alternative input] in the menu button of the SPL 

Editor then select [DC server black]. 
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After selecting [DC server black], the Alternative input dialog window will pop up. 

 

 

 

Select a type of DC server black content in the Type drop down menu list. Types of DC server black 

content are as follows: Black, Black 3D, and Black 3D 48. Enter the duration of DC server black content 

then click [OK] to add DC server black content. 

 

 

 

Note: Show playlists that contains DC server black content can be sent to ‘DC Server‘ type of  
screens only. 
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 Create Show Playlist with Intermission 

In the SPL editor list, intermission can be added to any CPL by right-clicking on the content then click 

[Add Intermission]. 

 

 

 

The Intermission Editor window will pop up, this will allow user to select a screen in the first drop down 

menu. Screens that will be listed in the first drop down menu are DC server type of screens only. The 

second drop down menu will then list down the available intermission playlists from the selected screen 

in the first drop down menu. 

Enter the cut position and the Rewind time of the intermission then click [Add] button. To remove 

intermission playlist, select an intermission in the list then click [Delete] button. 

 

 

 

An diamond shape will indicate that the content in the SPL editor list contains intermission. 
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 Create Show Playlist with Trigger Cues 

There are two types of trigger cues that can be added in a show playlist:  

1. Global trigger cue, this trigger cue will be available for all elements of the show playlist. 

2. CPL embedded  trigger cue, this trigger will only be available for the selected element of the show 

playlist. 

Note: Show playlists that contains trigger cues can be sent to ‘DC Server‘ type of screens only.  

 

 

5.2.1.4.1.  Global Trigger Cue 

To add global trigger cue to a show playlist, click [Alternative input] in the menu button of the SPL 

Editor then select [Trigger Cue]. 

 

 

 

After selecting [Trigger Cue], the Trigger cue dialog window will pop up. Select a screen in the screen 

drop down menu, screens that will be listed in this drop down menu are DC server type of screens only. 
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Select a trigger name and an automation cue in its corresponding drop down menus. Click [Add] button 

without ticking any checkbox in the CPL listed in the Optional section. Clip position of the trigger name 

will be ‘0‘ which means the trigger cue is set as a global trigger cue. To remove trigger cue, select trigger 

name in the list then click [Delete] button. 

 

 

 

Details of the trigger cue will be displayed in the SPL information area of the SPL editor. 
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5.2.1.4.2.  CPL Embedded Trigger Cue 

There are two ways to add CPL embedded trigger cues in a show playlist:  

First is in the SPL editor list, trigger cue can be added to any CPL by right-clicking on the content then 

clicking on [Add Trigger Cue]. 

 

 

 

The Trigger cue dialog window will pop up. Select a screen in the screen drop down menu, screens 

that will be listed in this drop down menu are DC server type of screens only. Select a trigger name and 

an automation cue in its corresponding drop down menu then click [OK] button. 

 

 

 

Another alternative to add CPL embedded trigger cue is by clicking on [Alternative input] in the menu 

button of the SPL Editor then select [Trigger Cue]. 

 

 

 

After selecting on [Trigger Cue], the Trigger cue dialog window will pop up. Select a screen in the 

screen drop down menu, screens that will be listed in this drop down menu are DC server type of 

screens only. 



5. CONTENT TAB 

 
  

 

13th April 2022 -72- User Manual for Theatre Management System TMS-2000  

Document Version 4.3.1.02 

 

 

 

Select a trigger name and an automation cue in its corresponding drop down menus. In the Optional 

section, tick the checkbox of the Clip name where you want to embed the trigger cue then click [Add] 

button. To remove trigger cue, select trigger name in the list then click [Delete] button. 

 

 

 

An square shape above the upper left part of the CPL will indicate that the content in the SPL editor list 

contains trigger cues. 
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5.2.2.  Merge Show Playlist 

 

To merge Show Playlist, drag another SPL into the SPL editor column to merge both SPL contents together. 
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5.2.3.  Delete Show Playlist 

 

To delete SPLs, choose [MANAGE] in Content Tab, select SPL name in SPL Tab, right-click and select 

[Delete SPL]. 

 

 

 

From the pop-up window, select the locations you wouldlike to remove from the playlist and click [OK]. 
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5.2.4.  Rename SPL 

The Rename SPL option allows the user to change the SPL name for the SPL loaded in the editor. 

To rename an existing SPL, select the SPL from the list of SPLs. Click on the "Rename SPL" button to give that 

SPL a new name. 
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5.3.  Content’s KDM Validity 

5.3.1.  KDM Validity Status in CPL and SPL tabs 

 

The KDM Validity status is displayed in the Validity column in all [CPL] sub-tabs and [SPL] sub-tab of Content tab. 

 

 

 

The table below shows the different validity status for KDMs: 

 

KDM Icon KDM Validity Status 

 

This icon indicates that the content does not need a key for playing. 

When the mouse cursor is on top of the KDM icon, it will display The CPL does not need a key  

for playing.  

 

This icon indicates that the content need a key for playing and the key needed is available in its 

corresponding server. The KDM’s validity date starts on current date onwards regardless of the 
time. 

When the mouse cursor is on top of the KDM icon, it will display The CPL can be played normally. 

 

This icon indicates the following scenarios: 

1. The content require KDM but it is not available in the server. 

2. The content requires KDM, the key needed is available in its corresponding server but it 

has expired. 

3. The content requires KDM, the key needed is available in its corresponding server but its 

validity is in future date. 

When the mouse cursor is on top of the KDM icon, it will display The CPL needs a key for playing. 
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This icon indicates that the KDM of the content is about to expire and its validity date falls on the 

alert day that is set in the Preference’s Alert Days configuration. Please refer on the Alert Days 
settings below. In the example, alert day is set to 10 days, this means that 10 days before the 

expiry date of the KDM, the icon of the KDM status will be changed to . 

When the mouse cursor is on top of the KDM icon, it will display The key of the SPL expires in 10 

days. 

 

This icon will be displayed if the content is about to expire and its validity date falls on the critical 

alert day that is set in the Preference’s Alert Days configuration. Please refer on the Alert Days 
settings below. In the example, critical alert day is set to 5 days, this means that 5 days before the 

expiry date of the KDM, the icon of the KDM status will be changed to . 

When the mouse cursor is on top of the KDM icon, it will display The key of the SPL expires  

in 5 days. 

 

In a scenario where there is a content having more than one KDM and these KDMs are having overlapping expiry 

dates, the KDM with later expiry date will be recognized by the system as the valid status. 

While in a case where there are two KDMs for a content, one of the KDM is about to expire and the other KDM 

has a future date, the system will recognize the KDM that is about to expire and will only change its validity status 

once the other KDM‘s future date validity is activated. 

Alert Days and Critical Alert Days for expiring KDMs can be configured in Preferences, click [Tools], 

[Preferences], [Alert Days]; enter values for the fields then click [OK] button. 
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5.3.2.  Purge Expired KDM 

KDMs that are more than one day expired can be removed from the server through Purge Expired  

KDMs function. To Purge expired KDMs, go to KDM tab to view the list of KDMs available. Right click any of the 

content in the list and choose [Purge expired KDMs (current view)...]. 

 

 

 

A window will pop up as seen below, click [OK] to proceed with the deletion of expired KDMs in the  

current view. 

 

 

 

In the example above, all KDMs that are more than one day expired will be removed from Hall 3 server only. 

Expired KDMs purged from servers will still be available in Theatre_Store. User need to select Theatre_Store in 

the Media List drop down menu then do purge expired KDMs to remove from the TMS Theatre_Store. 
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6.  SCHEDULER TAB 

By clicking the SCHEDULER tab, the interface will be shown as below.  

 

 

 

 

The Scheduler tab window consists of three parts:  

1) Schedules Setup: Users can setup schedules or view schedules. 

2) All Screens: At the left side, it shows all the screens connected to TMS. 

3) Show Schedule: On the right side, all scheduled shows are shown. A timeline which is red in color will keep 

moving according to current time. 

 

 

 

 

 

 

 

 

 

 

1 

2 

3 
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6.1.  Show Scheduling 

User can create new playback schedules by clicking [New] or [POS] button. For schedule deletion, user can use 

the [Remove] button.  After creating schedules, user can choose to export the schedules into a html format file for 

reference. 

 

 

 

6.1.1.  Ad Hoc Scheduling 

To create a new schedule, click [New] button. A window with options to select a show playlist and playback time 

will pop up. User can select the Screen, Source of the SPL, SPL name, Date and Time of show and click [Add]. 

A new schedule will be shown on the exact date and time created.  

 

 

 

The show will be added to the calendar shown. The schedule information will be sent to the screen immediately 

if the screen is currently connected to the TMS or else it will encounter an exception in the Transfer Display 

window. If the schedules added are currently in queue in the Transfer Display window, it will be presented in 

dotted frame. The server will start the show automatically once the time is reached without requiring a projectionist 

to manually press play [] to start playback. 
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Note: The scheduler will not permit a schedule to be created with start-time in the past, based on the current 

system time. 

To replicate the same show schedule on other days, select [Set Recurrence Rule]. A window will be popped up 

with more options. 

 

 

 

Selecting the Required Recurrence option: repeat once on a selected day, repeat on the same week day in the 

next (up to 4) consecutive weeks, or repeat on next several consecutive days (up to two weeks). Only one option 

can be selected. Upon selection, all effective recurring dates will be listed in the Schedule recurrence dates 

column at the bottom. 
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Note: New schedules can be created for a disconnected screen and the non-synchronized schedule will be 

updated the next time the screen is connected to the TMS. Scheduled shows can be cancelled on the TMS from 

disconnected screens only when they have not yet been synchronized. Otherwise, TMS must be connected to a 

screen in order to cancel a schedule. 
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6.1.2.  POS Scheduling 

Schedules can be added to servers to match the show time in POS data files exported from ticketing systems. 

To achieve this, tick [Enable POS Sync Manager] checkbox and set [POS URL] in the Preference Menu. Once 

the POS is setup properly, the TMS will continue to periodically update the latest POS data file and make 

rescheduling changes as they occur in the POS. For more details, refer to the Section 8.5. that covers the POS 

data setup. 

 

 

 

At SCHEDULER tab, click [POS] button, the POS Scheduler UI will pop up for POS schedule setup. 
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The POS data will provide movie titles, auditorium numbers and show times. Since the POS is a separate system 

from the TMS, map the auditorium number in POS to the appropriate screen on the TMS by clicking the [Map 

Screen to Aud.] button as seen below. 
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In the right hand column, select the numbers from the dropdown list in order to change the auditorium number for 

each screen.The mapping must be one-to-one. 

 

 

 

After both screen and auditorium are mapped to one another, choose the POS movie title in the left window in 

order to see the POS showtimes associated with that auditorium in the right window. Then the selected movie 

can be mapped to an SPL available on the appropriate screen by choosing the SPL from the pulldown list. By 

manually clicking the [Map Title] button, the selected SPL will be mapped to the server according to the 

schedules. Before mapping, the POS show icon is red while icon of mapped show is green  . Once user 

removed the schedule, its corresponding POS show icon will turn back to red . 
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Auto-creation of scheduled shows in POS is supported by TMS can be enabled in Preferences, click  [Tools], 

[Preferences], [POS]; tick [Auto create schedule if show is mapped] checkbox in the Advance section, then 

restart TMS for changes to be effective. Scheduled shows in POS should be mapped to TMS SPLs in order for 

TMS to auto create scheduled shows. 

  

 

 

To map SPLs to the POS data which will then map to server automatically, click [Advance] button, select POS 

Aud, POS Title, Source of SPL, and SPL. TMS supports to offset to the first trailer or offset with given seconds of 

time. This offset setting allows user to adjust showing time for real show playlist. For example, if the selected SPL 

has multiple items inside and before first trailer there are several adverstisement clips to play, the duration could 

be 10 minutes, then if POS show time is 20:10 and once user chose [Auto offset to first trailer], the real showing 

time is 20:00. System will start to playback first trailer from 20:10, Offset time value will allow the show to start 

earlier or later than POS show time by assigned number of seconds. For example, if user chooses minus 900 

seconds, that means the show will start 15 minutes earlier than its time in POS system. 

 

 

 

After mapped, the entries will be similar as shown below. Click [X] to close this window. 
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In case the show has been removed from POS, TMS can automatically delete related schedules if [Auto delete 

mapped schedule if POS show is removed] function is enabled in POS setting. Auto deletion of mapped 

scheduled shows from POS can be enabled in Preferences, click [Tools], [Preferences], [POS]; tick [Auto 

delete mapped schedule if POS show is removed] checkbox in the Advance section, then restart TMS for 

changes to be effective. 
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Schedule creation may fail due to schedule conflicting with the exisiting one, user has to delete the old one 

manually and make mapping again. 
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6.1.3.  POS Scheduling with TMS Template System 

POS scheduling with TMS Template System can speed up the scheduling process and reduce human intervention 

so to reduce human error. TMS Template System can be enabled in Preferences, click [Tools], [Preferences], 

[POS]; tick [Enable TMS template system] checkbox in the Advance>>Auto-SPL  section, then restart TMS for 

changes to take effect. 

  

 

 

Once the template system is enabled, when users click  [POS] in Scheduler tab, the TMS Template System 

graphical user interface (GUI) will pop up. The default tab is POS title view (as shown below). This GUI consists 

of a series of tabs and subtabs that allow access to the various functions of the TMS Template System. 
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Alternatively, user can click the menu [View], [Template System] and the TMS Template System graphical user 

interface (GUI) will pop up. Template view is the default tab that will display when TMS template system is 

accessed this way. 
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 Template Editor Tab 

 

 

By clicking the [Template Editor] icon, the Template view interface will be loaded as below. TMS Template 

System provides three built-in templates, which are General template , Intermission template, and SVM 

template respectively. 

User should be able to [Add], [Remove], [Edit], [Manage], and [Export] templates available in the Template 

view. The following are the functionality of the buttons available in the Template view: 

• [Add] button allows users to create user-defined templates.  

• [Remove] button allows user to delete the user-defined template that is selected in the list. 

• [Edit] button allows user to modify the template name only for user-defined templates that is selected in 

the list. 

• [Manage] button allows user to configure the placeholders that will be used for the selected template. 

Both TMS built-in templates and user-defined templates can be configured by the user. 

• [Export] button allows user to export the Templates in .xml format. 

 

Note: Built-in templates of TMS cannot be removed and edited by the user. 
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To add new template, click [Add] button. A New Template window will pop up. Users need to enter a name for 

the template, then click [Save].  

 

 

 

A new template named My Template will be created and listed in Template view. To manage the new template 

created, double-click My Template record in the Template view list, Template editor interface will be shown. 

  

 

 

In the Placeholder panel, there is a list of placeholders provided by TMS Template System. Users can add more 

placeholders by clicking [Add] button. A New template placeholder window will pop up. After entering data in 

all the mandatory fields, assign the restriction (Content Pack or Macro Pack), then click [Save].  TMS Template 

System provides default template placeholders for content packs: Early preshow placeholder (EPS), Feature 

end macro placeholder, Feature placeholder, Feature start macro placeholder, Intermission end macro 

placeholder, Intermission placeholder, Intermission start macro placeholder, International Advertisement 

placeholder, Late preshow placeholder (LPS), Local Advertisement placeholder, Pre show macro placeholder, 

and Trailer placeholder. 
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The new placeholder will be created and appeared in Placeholder panel. Users can click  icon to edit the 

placeholder or  icon to delete the placeholder. 

Note: Default placeholders cannot be deleted. 
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Drag the placeholder from Placeholder panel to Template Editor panel to add the desired placeholder to the 

template, then click [Save] to save the template.  

 

 

 

On the right side of Template editor, users can set the template to accept only unique placeholder by ticking 

[Accept unique placeholder only] checkbox. By enabling the unique placeholder, duplicate of the identical 

placeholder is prohibited. 

 

 

A warning message box will pop up if there is an identical placeholder added in the template editor panel. 
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To allow the desired template to be selected by TMS Template System to generate the SPL automatically, 

users need to set the template as the default template by checking the Default template checkbox. 

 

 

Please note that there can be only one default template at any given point of time. 

The Template editor allows users to define multiple templates and set those templates as active by making 

use of POS Titles restrictions as shown in the figure below: 

 

 

 

When POS title(s) restrictions are set for a particular template, the TMS will  use the design of that particular 

template to generate the SPLs for the restricted POS titles. For all other POS titles, the template system will 

use the design of the Default template for SPL generation. 
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Click [Reset] to go back to the original phase of the template or click [Back] to exit Template editor without 

saving. A warning message box will pop up when [Back] button is pressed to notify users that all the unsaved 

data will be lost after quiting Template editor. Click [Yes] to quit, [No] to continue. 
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 POS Title Editor Tab 

 

By clicking the [POS Title Editor] icon, the POS title view interface will be loaded as below. This will display 

information such as POS titles and its Rating that were retrieved from the POS File/URL. 

 

 

 

 

 

Click [Vacuum] to remove the list of titles that are no longer in the POS system. Confirmation message box will 

pop up, click [Yes] to continue, [No] to cancel. 

 

 

 

 

Only the existing POS titles will remain in the list and the [Vacuum] button will be disabled. 
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Alternatively, user can also delete individual POS titles by selecting the particular POS title to be deleted and 

clicking the [Delete] button. Confirmation message box will pop up, click [Yes] to continue, [No] to cancel. 
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Click [Aud Mapping] to map the auditorium number in POS to appropriate screen on the TMS. Aud mapping 

dialog will pop up to allow users to map the auditoriums to TMS. On the right hand column, select the screen 

from the dropdown list to map the screen to the auditorium number, then click [Save]. 

 

 

 

After both screen and auditorium are mapped to one another, double-click the CPL title to associate CPL or 

click the CPL title, then click [Match title], POS title editor interface will be shown. Drag feature CPL from the 

list and drop on Content Editor, then click [Save].   

Click  icon to remove CPL from Content Editor. 
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User can configure the Credit Offset value for a POS title, this will indicate the cue time on when the Credit TMS 

macro will be executed when the show is finished. (Refer to Section 7.23 for steps to map server macros with 

TMS macros, Credit TMS macro should be included in the pre-defined list of TMS macros.) 

 

 

 

 

 

Pre-show offset timing on POS titles can be configured by the user in the Pre-show offset field. This offset is 

used in instances wherein the feature content comes with pre-movie advertisements/trailers/short videos but the 

user still prefers to align the POS schedule time with the actual start time of the feature content. Once this offset 

is configured, template system should generate scheduled shows based on the defined  pre-show offset value. 
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Intermission for a feature content can be set by ticking the [Set intermission] checkbox, this will enable the 

Entry and Rewind fields. User should be able to configure the Entry value for the intermission, this will indicate 

the cue time on when intermission for the feature content will start playing while the Rewind field will indicate 

the rewind duration for the feature content once the intermission is done playing. 

 

Note: The Rewind feature only works with single-part feature content and not with multi-part feature content. 

 

 

 

 

Click [Back] to exit Template editor without saving. A warning message box will pop up when [Back] button is 

pressed to notify users that all the unsaved data will be lost after quiting Tempalate editor. Click [Yes] to quit, 

[No] to continue. 

The Template System Editor will show POS title view UI when [Back] is pressed. Click [Update] to update the 

list of POS title shown. Before template system generates POS schedules and show playlists, the POS status 

icon is red  while icon of mapped show is green . Click [Back] to exit POS status view interface.  
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 Multipart Content Editor Tab 

 

In many cases, the Feature content is received in multiple parts, for example Part 1 and Part 2. 

In such cases, the Multipart Content Editor tab should be used to first associate all such CPLs together by 

following the process mentioned below. 

By clicking the [Multipart Content Editor] icon, the Multipart content view interface will be loaded as below. 

User should be able to [Add], [Remove], and [Manage] multipart contents available in the Multipart content 

view. The following are the functionality of the buttons available in the Multipart content view: 

• [Add] button allows user to define new multipart contents from the CPL list. 

• [Remove] button allows user to delete the selected CPL title in the multipart content list. 

• [Manage] button allows user to modify existing multipart content available in the list. 

 

 

 

To add a new multipart content, click [Add] button. Multipart content editor interface will be shown. Drag 

multipart CPLs from the list and drop on Content Editor, then click [Save]. 

Click  icon to remove CPL from Content Editor. 
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Click the created CPL title to check the associated CPLs at the right panel. 

 

 

Once the Feature CPLs are associated in the Multipart Content tab, please follow the process to map the 

Feature CPLs with the POS Titles as explained in Section 6.1.3.2.  
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The following figure shows a POS title association with Multipart content. 

 

 

 

In case, an intermission is programmed for a Feature with multipart content; then the intermission content is 

assembled in between the multipart content.  

 

The following figure shows a typical SPL assembled with Multipart Feature content and an intermission. 
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 Content Pack Editor Tab 

 

 

By clicking  [Content Pack Editor] icon, the Content pack view interface will be loaded as below. 

User should be able to [Add], [Remove], [Edit], [Copy], [Manage], and [Export] content packs  

available in the Content pack view. The following are the functionality of the buttons available in the Content 

pack view: 

 

• [Add] button allows user to create user-defined content packs.  

• [Remove] button allows user to delete the user-defined content pack that is selected in the list. 

• [Edit] button allows user to modify the name of user-defined content pack that is selected in the list. 

• [Copy] button allows user to copy existing content packs, copied content pack is expected to have exactly 

the same configuration with the selected content pack in the list. 

• [Manage] button allows user to configure the contents, placeholder value and restriction settings of the 

content pack. Both TMS default content packs and user-defined content packs can be configured by the 

user. 

• [Export] button allows user to export existing Content packs in XML format. 

Note: TMS default content packs cannot be removed and edited by the user. 
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TMS Template System provides five default content packs: Feature pack, Intermission content pack, 

International advertisement pack, Trailer pack and Local advertisement pack. Double-click the desired default 

pack or click the pack name, then click [Manage] to edit. 

Click [Add] button to add new content pack. New content pack window will pop up. Users need to enter a name 

for the pack, then click [Save]. 

 

 

 

The created content pack will appear in the list in Content pack view interface. The details of the content pack 

will be displayed at right panel. 

 

 

 

Double-click or select the desired content pack, then click [Manage] to edit. Content pack editor interface will 

be loaded. Drag and drop CPLs to Content Editor, then click [Save]. 
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Users can also set some restrictions to the content pack.  

The placeholder for the content pack can be set by choosing a placeholder from  the set placeholder dropdown 

list. The set placeholder dropdown is locked by default. User need to click on the lock icon to unlock the 

dropdown and select the desired placeholder from the list of placeholders. 

 

 

 

Tick on [Set POS Rating restriction] checkbox under POS rating section, a dropdown menu will display a list 

of the POS ratings that were retrieved from the POS File/URL. User will be able to select a POS rating in the 

drowndown then click [Save] button to save the restriction setting. 
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Users can set the active period of the content pack by ticking [Set date restriction] under Date range section 

or [Set time restriction] under Time range section. If [Set date restriction] is ticked, input the Start and End 

date for the content pack to be active. For example, if the Start date is set to 20-Jan-2017, and the End date is 

set to 28-Feb-2017, then the content pack will be active from 20-Jan-2017 00:00 until 28-Feb-2017 23:59. 

Meanwhile,  users can also set the time range for the content pack to be active. If the Start time is set to 01:00:00 

and End time is set to 15:00:00, this mean the content pack will be active from 01:00:00 until 15:00:00 everyday.  

When both of the date restriction and time restriction are set, the content pack will only be active within the set 

period. 

 

 

 

Note: The minimum gap for the date range is one day while the minimum gap for the time range is one hour. 

Users can also set the content pack restrictions according to the Days of the week by setting the [Set day 

restriction]. This will be on top of the [Set Date restriction] 

For e.g. If the date restriction of a content pack is set to start from 1-7-2021 and end at 31-7-2021 but the days 

restriction is set to Wednesday, Thursday and Friday, the pack will only take effect on the selected days of the 

week between 1-7-2021  to 31-7-2021. 
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Tick on [Set POS Title] checkbox under POS Title section to enable POS Title restriction. Click  icon, this 

will display the POS Title restriction window. It will allow users to select the POS title restriction by ticking at the 

checkbox, then click [Save] button to save the setting. Repeat the same steps if users wish to set Screen 

restriction or Attribute restriction for the content pack. 

 

   

 

Configured restrictions for POS Title, Screen restriction, and Attribute restriction will be displayed as shown 

below. 
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Tick [Set priority value] checkbox to set the priority of the content pack. The higher the priority, the higher the 

chance of the content pack being selected by TMS Tempalate System during auto SPL generation. 

 

 

 

Note: The value for highest priority is 10 while the lowest priority value is 0. 

 

Untick the checkbox to remove the setting set. A warning message box will pop up. Click [Yes] to continue 

while [No] to cancel. 

 

 

Restriction on content packs can also be set based on the format of the feature CPL. 

Tick the [Set format of feature CPL restriction] check box and click on the setting icon. 
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Select the feature formats for which the restriction should be set and click [OK]. 

 

 

 

The selection formats will be displayed below the ‘Set format of feature CPL restriction‘ option. 
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 Macro Pack Editor Tab 

 

 

By clicking [Macro Pack Editor] icon, the Macro pack view interface will be loaded as below. 

User should be able to [Add], [Remove], [Edit], [Copy], [Manage], [Configure], and [Export] macro packs 

available in the Macro pack view. The following are the functionality of the buttons available in the Macro pack 

view: 

• [Add] button allows user to create user-defined macro packs.  

• [Remove] button allows user to delete the user-defined macro pack that is selected in the list. 

• [Edit] button allows user to modify the name of user-defined macro pack that is selected in the list. 

• [Copy] button allows user to copy existing macro packs, copied macro pack is expected to have exactly 

the same configuration with the selected macro pack in the list. 

• [Manage] button allows user to configure the contents, placeholder value and restriction settings of the 

macro pack. Both TMS default macro packs and user-defined macro packs can be configured by the 

user. 

• [Configure] button allows user to configure options on how template system will utilize usage of Black-

related contents.   

• [Export] button allows user to export an existing macro pack in XML format. 

Note: TMS default macro packs cannot be removed and edited by the user. 
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TMS Template System provides five default macro packs: Pre show macro pack, Feature start transition pack, 

Feature end transition pack, Intermission start macro pack, Intermission end macro pack. Double-click the 

desired macro pack or click the macro pack name, then click [Configure] to configure. Macro pack setting view 

UI will be loaded. 

 

 

 

By default, all the three settings are ticked to optimize the Template System. 

• [use server black for TMS supported server] is to enable Template System to pick server black from 

TMS supported server. For example, if [use server black for TMS supported server] is ticked, no CPL 

will be created in Doremi Server because Doremi Server has its own server black. 

• [use default content whenever applicable] is to enable Template System to pick default content from 

the servers. 

• [automatically merging black in the same content] is to enable Template System to merge all the 

TMS Blacks that associated with the macro pack together to become only one TMS Blacks. For example, 

users added three TMS Blacks, each with the duration of two seconds. Instead of using six Black MOS 

1s to fit this case, the three TMS Blacks will be merged and become only one TMS Black with the duration 

of six seconds. Then only one Black MOS 5s and one Black MOS 1s will be added in the SPL.  

• When [use default content whenever applicable] is ticked, a list of Black MOS content will show in 

Macro pack content panel.  
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Note: All Black MOS contents should be ingested into TMS before using TMS Template System. If no suitable 

Black MOS contents are found in any of the servers, the SPLs generated will not have any TMS Black and 

macro associated. 

Click [Save] button to save the setting or [Back] button to exit Macro pack setting view without saving. 

To manage macro packs, click the desired macro pack title, then click [Manage] button, else, double-click the 

desired macro pack title. Macro pack editor interface will be loaded as shown below. Drag and drop contents 

to Content Editor then click [Save].  
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Note: Server macros need to be mapped with TMS macro before using the Template System. (Refer to Section 

8.24. for details regarding mapping of server macros with TMS macros). 

Users can also set some restrictions to the macro pack. 

The placeholder for the macro pack can be set by choosing the appropriate placeholder from the set placeholder 

dropdown list. 

The set placeholder dropdown is locked by default. User need to click on the lock icon to unlock the dropdown 

and select the desired placeholder from the list of placeholders. 

 

 

 



6. SCHEDULER TAB 

 
  

 

13th April 2022 -116- User Manual for Theatre Management System TMS-2000  

Document Version 4.3.1.02 

 

Users can set the active period of the macro pack by ticking [Set date restriction] under Date range section 

or [Set time restriction] under Time range section. If [Set date restriction] is ticked, input the Start and End 

date for the macro pack to be active. For example, if the Start date is set to 20-Jan-2017, and the End date is 

set to 28-Feb-2017, then the macro pack will be active 20-Jan-2017 00:00 until 28-Feb-2017 23:59. 

Meanwhile, users can also set the time range for the macro pack to be active. If the Start time is set to 00:00 

and End time is set to 15:00, this means the macro pack will be active from 00:00 until 15:00 everyday.  

When both of the date restriction and time restriction are set, the macro pack will only be active within the set period. 

 

 

Note: The minimum gap for the date range is 1 day while the minimum gap for the time range is one hour. 

Users can also set the macro pack restrictions according to the Days of the week by setting the [Set day 

restriction]. This will be on top of the [Set Date restriction] 

For e.g. If the date restriction of a macro pack is set to start from 1-7-2021 and end at 31-7-2021 but the days 

restriction is set to Wednesday, Thursday and Friday, the macro pack will only take effect on the selected days 

of the week between 1-7-2021  to 31-7-2021. 
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Tick on [Set POS Title] checkbox under POS Title section to enable POS Title restriction. Click  icon, this 

will display the POS Title restriction window. It will allow users to select the POS title restriction by ticking at the 

checkbox, then click [Save] button to save the setting. Repeat the same steps if users wish to set Screen 

restriction or Attribute restriction for the content pack.  

 

   

 

 

Configured restrictions for POS Title, Screen restriction, and Attribute restriction will be displayed as shown 

below. 

 

 

Tick [Set priority value] checkbox to set the priority of the macro pack. The higher the priority, the higher the 

chance of the macro pack being selected by TMS Tempalate System during auto SPL generation. 
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Note: The value for highest priority is 10 while the lowest priority value is 0. 

Untick the checkbox to remove the setting set. A warning message box will pop up. Click [Yes] to continue 

while [No] to cancel. 

 

 

Restriction on macro packs can also be set based on the format of the feature CPL. 

Tick the [Set format of feature CPL restriction] check box and click on the setting icon. 

 

 

 

Select the feature formats for which the restriction should be set and click [OK]. 
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The selection formats will be displayed below the ‘Set format of feature CPL restriction‘ option. 
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 Advance Usage Tab 

 

 

By clicking [Advance usage] icon, the Advance Usage interface will be loaded as below. The default interface 

for Advance Usage tab is Template POS mapping (as shown below). This interface allows user to do manual 

template POS mapping and configure settings for POS Offset and Screenvision Media (SVM) options. 

 

 

 

6.1.3.6.1.  Manual Generation of Scheduled Show and Show Playlist 

Advance Usage tab provides user an interface to let users manually generate template system tasks such as 

POS schedules and show playlist. User can manually generate template system task in few ways: per each 

show entry, per POS title, and per screen. To manually generate template system task, select a POS show 

entry in the list, then click [Generate] button. 
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In the scenario above, POS Title “WONDER WOMAN” with Start Time “2017-08-03T10:15:00” and “2017-08-

03T16:15:00” is selected, once the user clicks the [Generate] button, template system will generate its 

corresponding schedules and show playlist.  
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Checkbox for selection of POS Titles will only be available to the user if the POS Titles are not yet mapped. 

Before manually generating template POS schedules, the POS status icon is red  while icon of mapped 

show is green . 

 

 

6.1.3.6.2.  Template POS Options 

To configure settings for POS Offset and Screenvision Media (SVM) options, click [POS] button in the 

Advanced Usage interface. Once POS offset is configured, template system should generate POS 

schedules based on the option that is selected by user. 

 

 

 

Under POS Offset section, user can configure POS Offset settings by selecting one of the options provided. 

Default POS Offset configuration is set to None. The following are the offset options available for the user: 

• Option: “None” 

If this option is selected,  no POS offset will take effect once POS schedules are created by template 

system  

• Option: “Auto offset to first trailer” 

If this option is selected, POS schedules that are created by template system will align according to the 

first trailer type of content in the show playlist. 
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• Option: “Auto offset to feature” 

If this option is selected, POS schedules that are created by template system will align according to the 

feature content in the show playlist. 

• Option: “Screenvision media (SVM) offset to end of early preshow (EPS) placeholder” 

If this option is selected, POS schedules that are created by template system will align after the last 

content of the early preshow (EPS) placeholder in the show playlist. 

• Option: “Manual offset (in sec)”, wherein user needs to define the offset. 

 

 

 

If this option is selected, POS schedules that are created by template system will align according to the 

predefined offset of the user in seconds. In the scenario above, POS offset is set to 60 seconds, this means 

POS schedules that are created by template system will be 60 seconds earlier than the POS schedule time 

retrieved from POS File/URL. 

During the template system creation of POS schedules, TMS can trim advertisement contents in the early 

preshow placeholder to prevent schedule overlap. This is done by ticking the [Enable SVM trimming on 

EPS placeholder] checkbox in Screenvision Media (SVM) options section.  

 

 

 

The ‘Enable push update’ setting allows the TMS Template system to automatically update any changes 
made by ScreenVision to the XML packs. 

 

 

 

Click [Save] button to save the changes for POS Offset and Screenvision Media (SVM) options. 
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6.1.3.6.3.  Typical Scenario/Example for POS Scheduling 

6.1.3.6.3.1.  Configure POS Settings 

 

Click [Tools], [Preferences], [POS]. The POS window will pop up. 

 

 

 

Step 1: 

Tick  [Enable POS Sync Manager] checkbox to enable POS system and select a 

POS Vendor. In this case, the POS Vendor used is RADIANT – v1.5. Then enter the 

POS URL, set the refresh timing, authentcation token, and range for TMS schedule 

syncing. 

Step 2: In the advance section, tick [Auto create schedule if show is mapped] checkbox. 

Step 3: 

In the advance section, tick [Enable TMS template system] checkbox. 
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6.1.3.6.3.2.  Manage Template 

Go to Scheduler tab, click [POS], the Template System Editor will pop up. POS title view is 

the default interface of Template System Editor. 

 

 

Step 1: 

Switch to Template view by clicking Template Editor tab. 

  

Step 2: 

Double-click General Template (default) to manage. Template editor interface will be shown. 
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Step 3: 

Set the Default template by ticking Default Template checkbox. 

 

Note: There can be only one Default Template at any given point of time. 

Step 4: Click [Save] to save the setting of the template. 

 

 

6.1.3.6.3.3.  Manage POS Title 

 

Step 1: 

Switch to POS title view by clicking POS Title Editor tab. 

 

Step 2: 

A list of CPL title will be displayed in POS title view. 

Click the [Vacuum] button to remove the title that are no longer in POS system. 

 

Step 3: Double-click the title to associate feature CPL to it. 

Step 4: 

Click [features] tab, a list of feature CPL will be shown. 

Drag and drop the CPL that needs to be associated to the CPL title to Content Editor panel. 

In this case, WonderWomanGdc_FTR-1_F_51_2K_20170728_SMPTE_OV is dropped to 

Content Editor.  
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Step 5: Click [Save] to save the feature pack. 

 

 

 

6.1.3.6.3.4.  Manage Content Pack 

Step 1: 

Switch to Content pack view by clicking Content Pack Editor tab. 

 

Step 2: A list of default content pack will be displayed in Content pack view. 
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Step 3: 

Double-click each content pack to associate corresponding CPLs. 

(In this case, we demonstrate International Advertisement pack.) 

Drag and drop the following contents into the Content Editor: 

- VISA_BUNGEE_30s_NEW_SOUND_Imax 

- CanonPixma_MagicalConnections_30s 

 

Step 4: Tick  [Set screen restriction] checkbox, tick Hall 1 and Hall 2, then click [OK]. 
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Step 5: Click [Save] to save the content pack. 

 

 

6.1.3.6.3.5.  Manage Macro Pack 

Step 1: Switch to Macro pack view by clicking Macro Pack Editor tab. 

 

Step 2: A list of default macro pack will be displayed in Macro pack view. 
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Step 3: Double-click each macro pack to associate corresponding CPLs. 

(In this case, we demonstrate Feature start transition pack.) 

Drag TMS Black (10 secs) from TMS Black tab and 3D FLAT from TMS Macro tab, then drop into Content Editor. Drag 

and drop the following contents into the Content Editor: 

- TMS Black (5 secs) from TMS Black tab 

- OPEN DOWSER from TMS Macro tab where cue point is set to 00:00:00 

- 3D FLAT from TMS Macro tab where cue point is set to 00:00:03 

 

Step 4: Tick [Set screen restriction] checkbox, tick Hall 1 and Hall 2, then click [OK]. 
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Step 5: Click [Save] to save the macro pack. 

 

 

6.1.3.6.3.6.  POS status view 

POS status view interface provides an overview of the POS Title status and its associated 

SPL/s generated by the template system. To access POS status view, click the [POS Title 

Editor] icon, then click [POS Status] button,  POS status view interface will be loaded. 

POS Status view table can be filtered by showing only the active POS status only by ticking [Show 

active POS status only] checkbox. 
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6.1.3.6.3.7.  Generated POS SPL view 

Generated POS SPL view provides a list of SPLs that were generated by template system. 

User can acces the Generated POS SPL view by clicking the [POS Title Editor] icon then 

click [POS SPL] button,  Generated POS SPL view interface will be loaded. 
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Purge function allows users to remove SPLs generated by the template system that is no 

longer mapped to any of the POS schedules. To purge unused SPLs for template system, 

click [Purge] button. 

 

 

A pop-up dialog will prompt to the user, click [OK] to continue with the deletion of unused 

SPL in the list. Click [Update] to update the list of SPLs that were generated by template 

system. 

 

Note: Purging of unused SPLs will not happen when the POS Sync is in progress. 
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6.1.3.6.3.8.  Check on Scheduler Tab 

Close Template System Editor, then switch to Scheduler Tab. 

 

 

 

Wait for the next POS syncing cycle (in this case, POS syncing interval is 30 minutes). When 

POS sync done, notice that SPLs, CPLs, and SCHs are transferred to Hall 1 and Hall 2. 

Schedule shows also being generated automatically and displayed in the scheduler timeline. 

Refer to Section 6.2. for more details on schedules. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



6. SCHEDULER TAB 

 
  

 

13th April 2022 -135- User Manual for Theatre Management System TMS-2000  

Document Version 4.3.1.02 

 

6.2.  View Schedules 

When the mouse cursor is on the scheduled show, a pop-up window will show the Start and End time of the SPL. 

 

 

To see the full details of the SPL, user can double-click the scheduled show and a pop-up window will be 

shown as below.  

 

 

 

Click [calendar] icon located on the top left corner or use the left and right arrows located on the top right 

corner to switch viewing schedules on other days. 
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When a warning icon   is shown beside the connected screen, it indicates error in the SPL, double-click the 

connected screen  to check the remarks column, which will indicate the type of errors. A yellow key means 

that the scheduled SPL has missing CPL and a red key means that the scheduled SPL has no valid KDMs 

available in the server. 

 

  

 

To check the Schedules error, click the schedule icon. Detailed Server Playlist information will be shown and the 

type of errors will be indicated below it.   
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6.3.  Export Schedules 

To export the Server schedules, click [Export Schedule] button. Select and choose to export Daily or Weekly 

schedules and click [OK].  The file will be saved as html format.  

 

 

 

After schedule is exported, the schedules can be viewed in a web broswer. 

Example of an exported Daily Schedule is shown as below. 
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Example of an exported Weekly Schedule is shown as below. 
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6.4.  Remove Schedule 

To remove schedule, first select a screen, then click [Remove] button.  From the SPL dropdown box, select the 

schedule to be removed. After selection, click [OK]  button. There is a  [Select All] option to remove all schedules. 
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7.  QUALITY TAB 

TMS-2000 with QMS-1000 will have a QUALITY tab in the graphical user interface which allows cinema auditorium 

quality control. 

 

 

 

The supported tests and setup include: 

 

Mode Single Projector Dual Projector 

2D 
Using 1 projector 

Using 1 projector 

2D Using 2 projectors 

3D Using 1 projector Using 2 projectors 

 

The sensor device needs to be added to TMS Software. Additionally, test content needs to be ingested into playback 

Servers and correct naming SPLs must be created in the playback Servers as well. 
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7.1.  Add Sensor device to TMS Software 

 

For sensor device to work with the TMS-2000, it must be added as a device and linked to a screen. From TMS-

2000 software, select Screen → Add Devices → Analyzer, as shown in the image below. 

 

 

 

Select the Device Model, enter the ID, Name, IP address and Port number, and select the Device which is linked 

to the server, and click “OK", as shown in the image below. 
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An entry will be shown below that the Analyzer is successfully linked to selected screen, as shown in the  

image below: 
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7.2.  Import and Distribution of Test Content and KDM 

 

The table below shows all the test content* needed in the server. Connect the external hard disk drive with content 

and ingest all content into the server. 

 

Sr. No Content Name 

1 QMS-CAL_TST-2D_F_2K_GDC_20150803_OV 

2 QMS-CAL_TST-2D_S_2K_GDC_20150803_OV 

3 QMS-CAL_TST-3D_F_2K_GDC_20150803_OV 

4 QMS-CAL_TST-3D_S_2K_GDC_20150803_OV 

5 QMS-CHK_TST-2D_F_71_2K_GDC_20150803_OV 

6 QMS-CHK_TST-2D_S_71_2K_GDC_20150803_OV 

7 QMS-CHK_TST-3D_F_71_2K_GDC_20150803_OV 

8 QMS-CHK_TST-3D_S_71_2K_GDC_20150803_OV 

9 QMS-CHK-DUAL_TST-3D_F_71_2K_GDC_20150803_OV 

10 QMS-CHK-DUAL_TST-3D_S_71_2K_GDC_20150803_OV 

11 QMS-CHK-DUAL-1_TST-2D_F_71_2K_GDC_20150803_OV 

12 QMS-CHK-DUAL-1_TST-2D_S_71_2K_GDC_20150803_OV 

13 QMS-CHK-DUAL-2_TST-2D_F_71_2K_GDC_20150803_OV 

14 QMS-CHK-DUAL-2_TST-2D_S_71_2K_GDC_20150803_OV 

 

 

Import test content into TMS-2000 using external Hard Disk Drive or through FTP. Please refer to Section 5.1.3.  

(Ingest DCP/KDM through Local Machine) and Section  5.1.4. (Ingest DCP/KDM through FTP) for details on how 

to ingest content into the TMS-2000. 

 

Once the ingestion is completed, the content will be added to the TMS theatre store as shown in the image below. 

 

** Kindly check with GDC for the latest QMS test content & corresponding KDMs.  
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From Theatre_Store, transfer all the test content to the playback Server that will run the test. Refer to Section 

5.1.9. (Content Transfer) for details on how to transfer content from TMS's theatre store to the playback servers. 

 

Once the transfer is completed, the content will be stored in both Theatre_Store as well as the selected server, as 

shown below. 

 

 

 

 

 

The content will not be able to playback without valid KDMs. The  icon in the below image indicates that the 

needed KDM is not yet available in the testing server. 
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Go to Theatre_Store, the “No” status under Transferred? column indicates that the KDMs in the Theatre_Store are 
yet to transfer to their corresponding servers. 

 

 

 

Under the KDM tab, select the content that are needed to be sent to the testing server & right-click at the 

selected content. Click “Send” button to send 

 

 

 

Additionally, refer to the Section 8.1. for setting up TMS to automatically transfer KDMs to playback servers 

after ingestion into the Theatre store. 
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7.3.  Server Playlist Creation and Transfer 

 

After ingesting content**, Server Play Lists (SPLs) will be needed to be created and transferred to the server. 

There are 14 SPLs that need to be created on the playback server. 

 

Sr. No Server Play List Name (SPL) Content Name 

1 QMS-CHK-S QMS-CHK_TST-2D_S_71_2K_GDC_20150803_OV 

2 QMS-CHK-F QMS-CHK_TST-2D_F_71_2K_GDC_20150803_OV 

3 QMS-CHK-3D-S QMS-CHK_TST-3D_S_71_2K_GDC_20150803_OV 

4 QMS-CHK-3D-F QMS-CHK_TST-3D_F_71_2K_GDC_20150803_OV 

5 QMS-CHK-S-DUAL-1 QMS-CHK-DUAL-1_TST-2D_S_71_2K_GDC_20150803_OV 

6 QMS-CHK-F-DUAL-1 QMS-CHK-DUAL-1_TST-2D_F_71_2K_GDC_20150803_OV 

7 QMKS-CHK-S-DUAL-2 QMS-CHK-DUAL-2_TST-2D_S_71_2K_GDC_20150803_OV 

8 QMKS-CHK-F-DUAL-2 QMS-CHK-DUAL-2_TST-2D_F_71_2K_GDC_20150803_OV 

9 QMS-CHK-3D-S-DUAL QMS-CHK-DUAL_TST-3D_S_71_2K_GDC_20150803_OV 

10 QMS-CHK-3D-F-DUAL QMS-CHK-DUAL_TST-3D_F_71_2K_GDC_20150803_OV 

11 QMS-CAL-S QMS-CAL_TST-2D_S_2K_GDC_20150803_OV 

12 QMS-CAL-F QMS-CAL_TST-2D_F_2K_GDC_20150803_OV 

13 QMS-CAL-3D-S QMS-CAL_TST-3D_S_2K_GDC_20150803_OV 

14 QMS-CAL-3D-F QMS-CAL_TST-3D_F_2K_GDC_20150803_OV 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

**Kindly check with GDC for the latest QMS test content & corresponding KDMs.  
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At Content Tab, select Create, and click "New SPL". 

 

 

 

Server Type window will pop up. Click the drop-down menu and select D-Cinema, then click “OK” button. 
 

 

 

SPL name window will pop up. Enter the corresponding SPL name in the text box, then click “OK” button. 
 

 

 
 

 

 

 

 



7. QUALITY TAB 

 
  

 

13th April 2022 -149- User Manual for Theatre Management System TMS-2000  

Document Version 4.3.1.02 

 

Select content [QMS-CHK_TST-2D_F_71_2K_GDC_20150803_OV] and drag into empty column below SPL 

Name, then click “Save SPL” button. Save SPL window will pop up. Check on Theatre_Store as the location and 
click “OK” button to save. The created SPL will be saved into Theatre_Store. 

 

 

 

 

Go to Content Tab, manage, locate "QMS-CHK-S" SPL, right-click and select "Send to..." 

 

 

 

SPL Transfer Display window will pop up. Check "Send SPL with needed content(s)". Then, check the destination 

server, then click “Send” button. 
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Click the Transfer  icon to check if the SPL is being transferred successfully. 

 

 

 

 

 

 

 

 

After all SPLs are created, a Pause automation cue at the 3rd second has to be added to both SPLs: ‘QMS-CAL’ 
and ‘QMS-CAL-3D’. This Pause cue is needed, so that the projector can adjust its brightness. 

 

 

 

Note: For the remaining 13 SPLs and contents, follow the same method of creating the first SPL used.  
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7.4.  Profile Setup 

 

A new profile has to be created before running a test. There are 4 profiles to be setup. 

 

Sr. No Profile Name Mode Aspect Ratio 

1 2D_Scope 2D Scope 

2 2D_Flat 2D Flat 

3 3D_Scope 3D Scope 

4 3D_Flat 3D Flat 

 

 

Go to Quality tab, click "Profile" which is located at the bottom left of TMS-2000 software. 

 

 

 

 

 

For 2D Scope profile, enter the Profile Name as 2D_SCOPE, select Mode as 2D, Aspect Ratio as SCOPE, enter 

the Warning and Critical values for Sound Pressure Level, Luminance and Chromaticity, or else user may also 

use the default values. Click “Save” button to save the settings. 
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For 2D Flat profile, enter the Profile Name as 2D_FLAT, select Mode as 2D, Aspect Ratio as FLAT, enter the 

warning and Critical values for Sound Pressure Level, Luminance and Chromaticity, or else user may also use 

the default values. Click “Save” button to save the settings. 
 

 

 

 

 

For 3D profiles, user needs to create both Scope and Flat profiles.  Select Mode 3D, Aspect Ratio, enter the 

profile name, input the tolerance values for sound pressure level, luminance and chromaticity, then click “Save” 
button to save. 
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When all four profiles, 2D_SCOPE, 2D_FLAT, 3D_SCOPE and 3D_FLAT have been created, click Profile to 

check on it. 
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Note:  

 

Recommended Warning Values Recommended Critical Values 

 

Sound Pressure Level: 0.5dB 

Luminance: 1.5FL 

Chromaticity: 0.003 

 

Sound Pressure Level: 1.0 dB 

Luminance: 3.0FL 

Chromaticity: 0.006 
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7.5.  Screen Information 

 

Information of screen, projector and sensor device are needed to be entered in each cinema hall 2D/3D profile. 

Right-click Test and click "Get Info" 

 

 

 

 

The auditorium data information window will be loaded. 
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Enter the Hall Screen information, Projector Distance, select Sound System type, Sensor Location and Projector 

Setup type. 

 

 

 

 

User should select Sensor installed location, it should be either Center or Rear location depending on initial 

sensor device physical installations. 

 

 

User should select the Single or Dual Projector used.      

 

 

 

For Light Efficiency, as the sensor device is mounted in the hall, there is no light efficiency factor for 2D. For 3D, user needs to 

measure the 3D light efficiency value and input into the column for better measurement accuracy. 
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Connect Chroma meter to the mounting stand kit. 

 

 

 

Put the Chroma meter to the center of the Auditorium, set the height of it to be around 1.5 meters. 

 

 

 

 

From the Barco Projector, select Alignment Test Pattern as shown below, and click the icon to activate it. 
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Using the projected Test Pattern, look through the Chroma Meter and ensure that it is shooting to the centre of 

the it. Once it is aligned properly to the center, lock and secure the Chroma meter to the mounting stand. 

 

 

 

 

 

Playback Full White Test Pattern from the server and measure the value of the brightness using the Chroma 

meter, record this value and it will be known as A. 
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Using the same setup, use a pair of 3D glasses and put it in front of the lens of the Chroma Meter, measure the 

value of the brightness, record this value and it will be known as B. 
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To get the 3D Light Efficiency value, it will be B/A.  Once calculated, enter this value into the Light Efficiency 

Column for single projector Setup.  Click OK, and it is completed. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Note: If the setup is using a 3D Dual Projector, select "Dual" projector, use the same 

method as above to measure the values of the 2D and 3D setup of both the Left (Up) 

Projector and Right (Lower) Projector, input the values into the Light Efficiency columns 
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7.6.  Running Tests  

7.6.1.  2D Profile - Optimal Projection Benchmark Values 

 

After both 2D and 3D profiles setup are completed and the screen information entered, user can select a profile 

and click on [Test] button to run a test. For Optimal Projection Values Test, check and ensure that the physical 

sensor device is mounted on the rear wall in the auditorium, for projector information, the sensor device 

location must be selected Rear. 

 

 

 

 

Select on 2D_SCOPE profile, click on "Test" button to start the test. 

 

 

 

 

 

When the test is in progress, the results will be updated in real time on the right graph. 
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When the test is completed, the results graph will be formed on the right. 

 

 

 

Click on the "Details" button on the bottom right to toggle the results to display in numerical mode. 

 

 

 

The results will be displaced in numerical mode. 

 

 

 

 

Once the test is completed, the test will check on the tolerance deviations initially configured in the profile and 

indicates that the test is "pass", "warning" or "critical" under their columns. 
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On the right graph, user can check the test results in more details. 

 

 

 

 

Right-click on entry and click "Set as Benchmark" to set current values as Benchmark values. 

 

 

 

 

 

Click on "OK" to save result as benchmark values. 
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As initial benchmark values had already been saved, click on "Test" button again to check current values 

against it.  The graph now shows both benchmark values and real time results.  

 

 

 

 

 

 

 

 

Note: For more details on running test for the remaining 2D & 3D profiles which have been set up on the 

TMS-2000 Software, refer to the QMS-1000 User Manual. Please contact GDC in case of any queries 
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8.  PREFERENCES 

Click [Tools], [Preferences] to list the system information and change system settings.  

The settings available are Alert Days, Auto Connection, Auto-PMA, Backup Storage, Content Email, Content 

Watcher, Data and Transfer, Device Proxy, Emergency, General, , Language, Library, Logs Export, Macro 

Mapping, Notification, Notification Log, POS, Quality, Restrict Ingest, Server Attribute, Server Management, 

Show Attribute, Server Buffer Time, Smart Restore, Theatre Information, TMS Backup, TMS Labs, 

TmsConnect Transfer, GDC TmsRemote (“TmsRemote”), Unmapped Devices, User Log and User Manager. 
 

Note: Only Admin and Superuser accounts can access this tab and modify system settings. 
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8.1.  Data and Transfer 

 

 

 

1 Auto Verify content 

 

When this option is checked, TMS will automatically verify every content after it 

is ingested successfully. 

 
 

Please refer to Section 5.1.11. for more details on how content verification 

functions on TMS. 
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2 Auto Content Transfer 

 

 
 

When the ‘Auto Content Transfer’ option is checked, TMS will check the 
scheduled SPLs every two hours. If there are any missing content or KDMs that 

are included in those scheduled SPLs, then TMS will do an automatic content 

transfer to the designated screens. 

 

It is highly recommended that all content is ingested directly into the TMS 

theatre store. 

 

If the content is available in the Playback Server(s) but not in TMS’s theatre 
store, TMS will then try to transfer the content from a Playback Server which is 

currently not in playback mode.  

3 Automatic KDM transfer  

after ingest 

 

 
 

When this option  is enabled, TMS will automatically transfer KDMs to their 

desginated screens once the KDMs are  successfully ingested into the TMS’s 
Theatre Store. 

4 Custom content source 

 

Content Source Selection allows user to set the source location for transfers. to 

be in either [Default] or [Custom] mode.  

 

 
 

If the [Custom Content Source] option is checked, then user can select the 

source location at the time of content transfer. 
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When this option is unchecked,, user will not be able to select the source for 

transfers as the selection of source locations will be disabled and TMS will 

select the first screen, followed by the second screen, and so on, in an orderly 

manner as it works on a load sharing principle.  

 

 
 

But if a screen is in error mode, TMS will not select it but in custom mode, user 

can select the source on this screen 

 

5 Fix ASSETMAP when 

transferring to Qube 

 

 
 

Note: This option is only supported for Qube Cinema Servers. 

 

When this option is enabled, TMS will fix the ASSETMAP of DCPs where the 

annotation text doesn't conform to SMPTE XSD standards, before sending  it to 

Qube servers. 

 

6 Purge Expired KDMs in 

 theatre store 

 

 
 

This option when enabled will automatically purge expired KDMs from the TMS 

Theatre store. 

 

Please refer to Section 5.3.2. for details on how expired KDMs are purged  

from TMS. 

7 
Stop transfer when the  

server does not have  

enough free space 

 

 
 

This option is applicable only when the Centralized Playback Feature  

is enabled. 
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When this option is enabled, the Streaming Content Library (SCL) software will 

stop trying to send backup content to the playback server if the server's local 

storage do not have enough free space for next day shows. 

 

8 Enable Automatic Theatre 

Store cleanup 

 

 
 

When this option is checked, and TMS detects that there is not enough free 

space in the data repository for incoming DCPs, it will automatically delete 

unused DCPs in the data repository based on the thresholds defined. 

  

9 Transfer settings 

 

The Transfer settings are used for transferring content from the TMS Theatre 

store to the playback servers.  

 

 
 

 

By default, TMS uses predefined credentials for content transfers to the 

playback servers. 

 

Users can also enable the Custom Transfer Source option and set their own 

credentials. In cases where custom credentials are being set, please ensure 

that thecredentials of the corresponding FTP account in the File Zilla Server 

Interface are also modified accordingly. 

 

Kindly refer to the TMS-2000 Installation Manual for detailed information on 

setting up DATA TRANSFER SETTINGS on TMS. 
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10 Schedule Content transfer and 

Storage Management 

 

 
 

 

When this option is enabled, the housekeeping Logic that deletes old DCPs 

available in the playback server, deletion is based on the ingested datetime of 

the CPL in the playback server. This will only work with GDC SX-3000 (9.0-

build447 or above). It does not support servers that have been set up for 

Centralized playback. 
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8.2.  Server Management 

Before using TMS to manage servers, users should register servers to TMS. By clicking [Server Management] 

icon, a window will pop up and a Server Management window (as below) will allow user to add new categories 

and servers to the TMS software. 

 

 

 

8.2.1.  Add Category 

Click [Category] Subtab and [Add Category] icon to add a new category.  A new category must be created 

before adding server.   
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8.2.2.  Add Server 

Click [Add Server] icon to add server to that category. Enter the name, IP and password of the server.  The IP 

address of the server should be correct, else it will not be able to connect with TMS later. 

  

 

 

Click [Type] to change the Server Type. Select the correct Category and click [OK]. 
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The supported server types for TMS are listed in the table below: 

 

Sr. No. Server Type 

1 SA-2100 

2 SX-3000 

3 RD2000 

4 China Giant Screen 

5 DSS100 

6 DC Server 

7 LMT300 

8 Solaria One 

9 CMS2200 

10  ICMP01 

11 QUBE 

12 IMAX 

13 SR-1000 

14 SR-1100 

15 Christie S3 

16 SONY XCT-M10 

17 SONY XCT-S10 

18 Dolby Cinema 

19 SX-4000 

 

After adding category and server, the information provided is added in its corresponding list. To edit the changes 

on server, click [Server] tab, select a server in the list and click [Properties] icon.  To delete the Category and 

Server records, click [Delete] icon.  There must be no servers in a Category before it can be deleted. 
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• Schedule Alignment: Schedules created by TMS should align with the playback server's time for 

accurate show scheduling. 

• Is Slave Server: The ‘Is Slave Server’ option should be used if the server that is being setup is a Slave 

server in a Dual IMB Setup. The corresponding Master server should be selected from the Master Server 

dropdown list to link the Master and Slave servers. 

 

 

 

• CPL Skipping: This feature allows cinemas to skip unwanted parts of the featured CPL and directly play 

the actual movie of the CPL. 

• Special Format: The special format option is an indicator to the Auto-SPL for automation of 4DX and 

ScreenX formats based on the TMS Macros defined for 4DX and ScreenX screens. 
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8.3.  User Manager 

By clicking User Manager icon,  the user management window will pop up.  

 

 

 

In the user management UI, the top column shows the categories of the user level, followed by the user groups 

and user information below.  

There are six user roles with different levels of access rights:  

1. Super User 

2. Show Manager 

3. Show Manager 2 

4. Projectionist 

5. Operator 

6. Operator 2.  

 

Sr. No. User Group Roles 

1 Operator 

Operator user accounts have the least access rights compared to the other account 

types. Users in this group can only export schedules, add contents and create show 

playlist but has no access to delete contents in TMS 

2 Projectionist 

Projectionist user accounts have all the access right of the operator group, plus this user 

can browse and activate current shows, play content including start and stop playback, 

and delete contents in TMS 
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3 Show Manager 
Show Manager user accounts have all the access right of the projectionist group, plus a 

full access in the scheduler tab to create, export and remove schedules of playlist. 

4 Show Manager 2 
Show Manager 2 user accounts have the same access rights as Show Manager except 

that it does not have access on the playback controls in MONITORING tab 

5 Operator 2 

The "Operator 2" user accounts have full rights to the «MONITORING ‘tab’», 
«SCHEDULER ‘tab’», «CONTENT ‘tab’», «QUALITY ‘tab’», and full rights in the Template 
system (excluding the «Template ‘tab’», «Macro ‘tab’» and «Advance ‘tab’» of the POS 
section.) 

6 Super User Super User accounts can do everything except accessing other superuser accounts 

 

The Admin account has all access rights including the ability to access any Super User accounts. Only one 

Admin account exists on each TMS, but all the other groups can have multiple users of the same level. 

 

8.3.1.  Create User 

Click  [Add] button at the bottom left corner of User Manager to add a new user account. 

 

 

 

After entering data in all the mandatory fields (marked with an * asterisk), assign the new user to the right user 

role and click [OK]. 
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8.3.2.  Browse and Modify 

By clicking  [Edit] button on the right side, an “Edit User Info” window will pop up as shown below. All user 

information can be edited except for the field “User UID”.  

 

 

 

After making the changes, click [OK] to save modifications. 
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8.3.3.  Change User Privileges 

Higher level users can change lower level users’ access privileges. Users with green ticks are active 
accounts, by clicking the ticks allows the user to enable/disable the account. 

 

 

 

A disabled user account cannot log into the TMS and its icon will have a red cross beside its name. It can 

be enabled and disabled. 
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User Password can be reset using the [Reset Password] option. 

 

 

 

A user account can be changed from its current group to another group using the [Change Group] button.  

 

  

 

To delete user account, select and highlight user name and click [Remove] button. 
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8.3.4.  Password Reset by User Itself 

Not all user accounts can access the User Manager module.  Any user can browse its own account information 

and reset its login password by clicking TMS, View Account (admin). 

 

 

 

A window will pop up and then allow user to browse the user account information and reset its password. 
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8.4.  User Log 

The User Log function allows users to browse user activity logs in TMS by date. It can be sorted by Time, 

User, Type and Details. 
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8.5.  POS 

After selecting the POS Setting icon, a window will pop up prompting the user to set the POS Vendor and path 

of the POS data file location. 

 

 

 

The supported POS vendors are listed in the table below: 

 

Sr.No POS Vendors  23 RADIANT 

1 GDC  24 REGAL 

2 ADMIT ONE  25 RETRIEVER SOFTWARE INC. 

3 ALLURE GLOBAL  26 RTS 

4 CENTER EDGE  27 SENSIBLE 

5 CLARITY PACER CATS  28 SHOWCASE 

6 CMTS  29 SPLYCE 

7 CRAIN ATLANTA  30 TCC 

8 CRIFST  31 TICKET PRO 

9 DING XIN  32 TICKET SOFT 

10 E-SCORE  33 TITAN 

11 FLAMINGO  34 UA POS 

12 G.A  35 VEEZI 
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13 GOLDEN DYNAMIC  36 VENUE 

14 HARKINS  37 VISTA 

15 HELLO  38 VISTA - China 

16 HUO LIE NIAO  39 VISTA – China Standard 

17 INGRESSO  40 VISTA – China Standard (Cloud) 

18 JACK ROE USA INC.  41 YUEKE 

19 NEXO SOLUCIONES  42 POSitive 

20 OMNITERM  43 GoGoCinema 

21 ORISTAR  44 INDY Point of Sale 

22 PENNY 
 

45 DING XIN V2 

 

 

8.5.1.  General 

In order to enable TMS schedule syncing with a supported POS system, tick [Enable POS Sync Manager] 

checkbox and input the location where the POS data will be stored and updated into [POS URL:] field. The 

POS URL points to the path to where the ticketing system periodically exports the POS data. TMS will sync 

with this data periodically, based on the time set in the [Refresh Timing (minute):] field in the POS Settings. 

To activate these settings, restart the TMS software after finalizing your changes. 

Note: If the POS Sync Manager is enabled, the TMS will automatically sync POS-Supplied data from POS 

URL after the TMS software restarts. If this feature is disabled, the POS Sync Manager will stop updating 

POS data after the TMS restarts, but previous POS data will still be available. 

 

 

8.5.2.  Advance Sub-tab 

Along with the POS Settings, the POS window also provides some advanced configuration options, which 

are available under the Advance sub-tab. 

[Auto create Schedule if show is mapped] option ensures that the scheduled shows are generated 

automatically by the TMS, during the next POS sync. Make sure that this option is enabled.  

You can also set the number of days up to which the schedules should be created, based on data 

available from the POS system. This can be done by setting the [Create schedules upto only x days] to 

the desired number upto which the schedules need to be created. The maximum number of days upto 

which schedules can be created is 15 days. 

TMS also allows the option to automatically recreate all the already created schedules once a day at a 

specified time. This can be done by enabling the [Recreate schedule every XX:YY time and prevent 

recreation for schedule that is starting in the next X hours] option.  
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The scheduled shows that were generated based on the POS data, can also be deleted automatically 

from the TMS, once they have been removed from the POS. To do so, make sure the [The Auto delete 

mapped schedule if POS show is removed] option is enabled. 

 

 

8.5.3.  Auto-SPL Sub-tab 

The Auto-SPL sub-tab, provides configuration options related to the TMS Template System. POS 

scheduling with TMS Template System can be enabled by checking the [Enable TMS template system] 

checkbox.  

 

 

 

 

The Timecodes Indicator feature as explained in the Monitoring Tab section, can be enabled by checking 

the [Enable Timecodes Indicator] option.  

 

The houskeeping settings to purge [Unused SPLs] and [Expired Content Packs] can be enabled by 

checking the respecive check boxes. The time-frame for housekeeping can also be set from this option. 

Please note that housekeeping time-frame can only be set during non-cinema operting hours. 

TMS application needs to be restarted for any changes to take effect. 
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8.5.4.  Edge Scheduling Sub-tab 

The Edge Scheduling sub-tab, allows users to set the default [Opening Show:], which should be played 

in all the screens before the first scheduled show for the day. This could typically be a playlist containing 

macros such as turn on the Auditorium Dimmer, turn on the Projector lamp, etc.. 

 

 

 

Additionally, users can also set the default [Closing Show:], which should be played in all the screens 

after the last scheduled show for the day. This could typically be a playlist containing macros such as turn 

off the Auditorium Dimmer, turn off the Projector lamp, etc.. 

Values for the Offset interval before the first show, as well as the Offset interval after the last show, can be 

set in minutes. 

 

8.5.5.  Automator Sub-tab 

The Automator tab, allows users to execute automation cues on the Server, based on the sale of tickets, 

in the POS system. To enable this feature, select the [Enable Automator] option. 

 

 

 

Using this drop-down menu, user can choose whether the POS Show time, or the Scheduled Show time, 

should be considered as the start time for the show. 
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The [Ticket Sale URL:] field, points to the location where the POS system periodically exports its ticket 

sales data. The TMS will monitor the ticket sale data file every minute for any changes. 

The Automator function provides two options to send automation cue(s) to the playback servers: 

• The first option allows user to trigger the specified automation cue, in case any tickets are sold in 

the POS system, before the start of a scheduled show. 

• The second option allows user to trigger the specified automation cue(s), in case of no tickets are 

sold in the POS system, after the start of a scheduled show. 

Ensure that the name of the automation cue(s) mentioned here, are already configured, and matches with 

what is displayed on the playback servers. 

For example: If the user wants to send a automation cue‚ ‘STOP‘ to the playback servers if there are no 
tickets sold 10 minutes after the show start, then the playback servers should have a corresponding cue 

called ‚‘STOP‘ for that automation event to take effect. 
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8.6.  Notification 

The Notifications function allows TMS to perform checks on the playback servers, and if there are any 

abnormalities, TMS will send an email to inform user. From [Tools] menu, click [Preferences], 

[Notification], click [Mail Server] button to configure the settings for TMS to send out an email. 

 

 

 

Note: The Mail Server Configuration can only be set using the Customize Server setting. Default Server 

setting is discontinued 
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Click [Setting] button on each checklist selected, select the recipients to receive the email notifications.  Click 

[OK] button, restart TMS to activate the changes. 
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8.7.  TMS Backup and Data Restore 

TMS Backup makes backup copies of TMS configuration and its database files, then save them to a directory 

known as GDC TMS' Backup. Backup file will be saved as Date and Time format: 

YYYYMMDD_HHMMSS.tmsbk2. For example: “20170113_211011.tmsbk2”. To use TMS Backup, enable the 

[Enable Backup Daemon] under Preference section in TMS Backup window. 

 

 

 

In case of operating system or GDC TMS software corrupted, reinstall TMS and use Data Restore to restore the 

backup files. At Windows Start Menu, locate GDC-TMS → Data Restore and click it. 
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GDC-TMS Data Restore window will load, click [Restore File], and select the location of the backup file and click 

[Open] and then [Restore]. User can still restore TMS 4.1 backup files [YYYYMMDD_HHMMSS.tmsbk]. 
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8.8.  Smart Restore 

Smart Restore allows user to backup and restore server data such as scheduled shows and OS 

configuration file for GDC servers. Backup can be scheduled or can be done immediately by clicking 

[Backup Now] button. TMS will create backup files for schedule, show playlists, KDMs and OS 

configuration file of the selected server. Backup Server data section will display the details of the latest 

backup done by the system. 

 

 

User can restore the schedules by selecting a screen in the Restore Scheduled Shows section and then click 

[Restore Now] button.  All the schedules, show playlists and KDMs of the selected screen will be restored. 
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8.9.  Library Management System 

Library Management System allows the adding of GDC LMS-1000 server for integration with the TMS. From [Tools] 

menu, click [Preferences], [Library Management System] icon. To add new library, click [Add Library] icon. A 

New Library window will pop up. Enter the Name, IP and Password of the GDC LMS-1000. 

 

 

 

Once added, the entry will be shown in the table as below. Click [X] icon at the top right corner of the window to 

close it. 

 

 

Go to Content Tab, [MANAGE], select from the dropdown list, and a Library icon is added to the list. 
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Select one LMS from dropdown list, and click the “Library” icon on the right side of the window to connect it. A red 
cross indicates that it is currently not connected to TMS. Click the icon once to connect it to TMS, once 

connected, the  icon will disappear. LMS is then ready for use with TMS. 
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8.10.  TmsConnect Transfer 

The TmsConnect Transfer is settings for use with GDC Central Management System software. When a DCP 

contents are being transferred from CMS to TMS, the contents will be stored in a temporary location on the Hard 

Disk Drive in TMS server.   

If there is only one Hard Disk Drive in the TMS server, no settings will need to be changed. If there are more than 

one Hard Disk Drives on it, select the one with huge space storage remaining.   

From [Tools] menu, click [Preferences], [TmsConnect Transfer] icon, select the Hard Disk Drive with a lot of 

space remaining (if there is more than one Hard Disk Drive in TMS server) and click [OK] button. 

 

 

 

When a DCP transfer is being issued from CMS to TMS, there will be a transfer status entry in Content → 

TmsConnect Tab in TMS Software. The DCP contents will be stored in into TMS Theatre_Store and the storage 

location will be the “Data and Transfer” directory defined in System Tab. 
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If DCP content is already present in TMS, the status will be “Pending” in TmsConnect, the user must choose to 
either [Overwrite] or [Skip Content] the transfer. 
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8.11.  Backup Storage 

Backup Storage allows user to back up the entire server contents to a local or network drive on TMS. From 

[Tools] menu, click [Preferences], [Backup Storage] icon to load the configuration window. Select on the 

Backup Storage Drive to be used on TMS PC, tick [Smart Backup] checkbox, click and select the screens to 

back-up the entire screen contents. Select on the minutes that TMS will check whether the screens content match 

the backup storage drive, if there are any changes, TMS will update it. 
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8.12.  Logs Export 

Logs can be extracted from TMS for data analysis and troubleshooting purposes. To extract logs, from 

[Tools] menu, click [Preferences], [Logs Export] icon. Select the date range of the logs to be extracted 

and the destination of the file to be saved.  Click [Start] button to start. 

 

 

 

When log extraction is complete, the file will be saved in the destination location. The file will be saved as 

TmsLogsExport_YYYYMMDDHHMMSS.zip format. For example: “TmsLogsExport_20210807035534.zip“. 
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8.13.  Theatre Information 

Relevant Theatre Information details can be saved in TMS. From [Tools] menu, click [Preferences], 

[Theatre Information]. Enter the details and click [OK].  To check previously entered data, click [Theatre 

Information] to retrieve it. 
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8.14.  Notification Log 

The Notification Log function allows user to browse the captured alerts/notification from server sent to the 

TMS. It can be sorted by Time, Device Name, Sender and Event Description. 
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8.15.  Auto-Connection 

By clicking the [Enable Auto-Connection] radio button, the TMS will connect all the selected screen 

servers automatically each time the TMS software is launched. Otherwise, the user must manually connect 

to each server. Use the [Select All] checkbox to select all servers.  
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8.16.  GDC TmsRemote 

The GDC TmsRemote (‘TmsRemote‘) utility allows user to have full access with the functionality of TMS’s 
Monitoring tab and Scheduler tab remotely using iPads. The TmsRemote icon in Preference, lists down all 

registered clients that are accessing TMS remotely. This allows user to configure Service Port and remove 

registered clients. The maximum number of clients allowed to register in TmsRemote depends on user’s 
license. 

 

 

 

To remove a registered client, select an existing client, then click  [Remove Client] button. Upon removing 

client from the TmsRemote list, iPad will not be able to access TMS remotely. 

 

8.16.1.  Register an iPad to TmsRemote 

To register an iPad to TMS, access the TmsRemote sofware in the user‘s iPad. Select TMS [Cinema’s 
TMS] that the user want to access remotely. 
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iPad will display the Validate Token page. 

 

 

 

Go to TMS, a prompt will be displayed with the token needed to register the user‘s iPad. Enter the number 
provided in the prompt in the Validate Token page in the user‘s iPad. Token is only valid for 50 seconds. 

 

 

 

After entering the token displayed in the TMS, user should now be able to access the TMS remotely 

through the iPad. 

 

 



8. PREFERENCES 

 
  

 

13th April 2022 -203- User Manual for Theatre Management System TMS-2000  

Document Version 4.3.1.02 

 

8.17.  Emergency 

TMS can set an automation cue in case of emergency. Enter the automation cue, then click [Verify].  This 

will list down whether all registered screens have the automation cue. Click [OK] to save the emergency 

automation cue. 

 

 

 

Check [Tools], Emergency will be available in the list. 

 

  

 

Upon selecting this, a pop-up window will be displayed and warns the user that the emergency alarm will 

trigger on every screen.  
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Enter the admin password to execute the emergency automation cue. 
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8.18.  Quality 

Quality function lets the user schedule a quality test on the selected screens everyday at the time indicated 

by the user. User should initially run a quality test for the screens before user can set a scheduled quality 

test, this initial test will be used as a benchmark when running quality test. 

 

 

 

Please refer to Section 7. of this document for detailed information on the Quality function. 
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8.19.  General 

General settings of TMS can be configured by accessing [General] in the Preference list. 

 

    

 

8.19.1.   CPL and DCP Data Cache 

In the CPL and DCP Data Cache section of General, user can delete the CPL and DCP data cache  of TMS 

by clicking [Clear] button. 
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8.19.2.   Automatic USB Drive Detection 

By enabling the [Enable ingest KDM on USB drive detection] checkbox in Automatic USB Drive Detection 

section, TMS will scan for valid KDMs and automatically ingest it when a USB is plugged in to TMS host 

machine. 

 

 

 

8.19.3.   Control Unlocking 

An added security on playback, projector and sound processorcontrols is enabled when user selects the 

check on [Password protected] checkbox in Control Unlocking section. 

 

 

 

This requires user to enter password whenever the  Lock icon is pressed in the Monitoring tab. 

 

 

 

8.19.4.   Enable Centralized Playback 

[Enable Centraized Playback] is a function of the Centralized Storage Playback Solution, and is supported by 

the SCL-1000 Mk2, SCL-2000 Mk2, SCL-3000 Mk2 or SCL-4000 Mk2 Centralized Playback Server 
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8.19.5.   Cinema Operating Times 

Cinema Operating Times section allows the user to configure the [Start Time] and [End Time] displayed 

in the PMA1000 Controls, under the sub-tab of Automation Management window. 

 

 

 

Values for the [Start Time] and [End Time] fields will reflect as Cinema Operating Times in the PMA1000 

Controls, under the sub-tab of Automation Management window. 

 

 

 

 

8.19.6.   Information for Double Column 

Information displayed in Monitoring tab when view settings is in double column can be configured in the 

Information Shown for Double Column section. Information will be shown based on the selected 

checkboxes of the user. 
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Click [View], [Monitor], [Double column], Monitoring tab view will display the screens in double column. 

 

 

 

8.19.7.   Scheduler Setting 

By default user is restricted to add overlapping schedules in the TMS Scheduler timeline but by ticking the 

[Enable schedule overlapping] checkbox in Scheduler setting section, TMS will allow users to create 

overlapping schedules by manually adding a new schedule, manually mapping POS shows, or through 

the auto-create mapped shows function of the POS.  

 

 

 

8.19.8.  Persistent Application 

The Persistent Application option when checked will ensure that the TMS application is running at all times.  
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8.20.  Language 

Language lets user to change the language settings of TMS. Languages available are: English [ENU], 

Simplified Chinese [CHS], Traditional Chinese [CHT], Spanish [ESP], Indonesian [IND], Japanese [JPN], 

Korean [KOR], Russian [RUS], Thai [THA]. 
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8.21.  Server Logs 

The Server Logs allow user to retrieve playback logs of the screens. It can be saved locally as XML file. 

Currently, retrieval of playback logs  is supported from all GDC server models, all Doremi server models, 

Dolby IMS series and Barco ICMP servers. 
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8.22.  Content Watcher 

The Content Watcher is a feature of TMS wherein TMS will keep on watching an FTP server for new DCPs 

and KDMs that are not yet available in TMS Theatre_Store. Once new DCPs and KDMs are listed, TMS will 

perform an automatic ingest to TMS Theatre_Store. 

In order to add FTP servers that TMS can watch at every timing interval, tick [Content Watcher] checkbox. 

Timing interval to watch the FTP server’s contents can be configured in [Minutes between every status 

update] field. 

 

Click [Add] to add new FTP source. 

 

 

 

Enter the details of the FTP source, tick the types of contents to watch, configure the kind of content to be 

ingested, click [Test] to check if the connection is sucessful, and click [OK]. FTP server will be added in Content 

Watcher’s first table. 
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Click [Update Now] to connect to the FTP servers added in the Content Watcher’s first table. The green dot 
beside the server name indicates that the FTP server is online, while the red dot indicates that it is offline. 

 

 

 

TMS will scan the server for DCPs and KDMs that are available in the FTP server and it will list down all the 

contents available in Content Watcher’s second table. Information of the content such as the File/Directory 
Name, Content Name, Type, Size, Percentage and Status will be available in the table. 
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The following icons indicates the content‘s ingest status: 

 - indicates that the content is ingested 

 - indicates that the content is waiting for ingest to start or the content is ingesting. 

 

Click [OK] in the Content Watcher window to save the configurations of Content Watcher. 
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8.23.  Web UI Access 

Users can view TMS Monitoring through Web UI. This allows user to view the real time status of the screens 

only. To access the Web UI, open a web browser, then enter "https://TMS_IP_Address:9005/“ in the 

address bar. 

 

 

 

Enter User Name and Password then click [OK] button. The web browser will display the real time status of the 

screens in TMS. Users can request for the user name and password from their local service providers. 
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8.24.  Macro Mapping 

The Macro Mapping feature of TMS allows users to map macros from different servers in the TMS macro 

table. Macro Mapping window provides an user interface for users to define the equivalent server macros 

and its parameters from the TMS macro list. Server macros list are retrieved from its respective server every 

time the user initializes a connection to the server. 

Default TMS Macros are as follows: 3D FLAT, 3D FLAT HFR, 3D SCOPE, 3D SCOPE HFR, 4DX_EMPTY, 

4DX_PLAY, 4DX_STOP, 4K 3D FLAT, 4K 3D SCOPE, 4K JPEG FLAT, 4K JPEG SCOPE, CREDITS, 

Dolby 5.1, Dolby 7.1, Dolby ATMOS, DOWSER CLOSE, DOWSER OPEN, DTS:X, JPEG FLAT, JPEG 

SCOPE, MPEG FLAT, MPEG SCOPE, PAUSE, PLAY, PRE-SHOW, SECOND CREDITS, SX_CLEAR, 

SX_PRJ_OFF, SX_SLV_OFF  

The default CREDITS TMS Macro is used by Template System as the credit cue that is placed in the credit 

offset configured for the POS title when generating schedules and show playlist. 

 

 

  

User is allowed to add/remove user defined TMS macros. To add user defined TMS macro, click  [New 

TMS Macro] button in the lower left corner of Macro Mappring window. The New TMS Macro window will be 

displayed, enter the TMS Macro name in the field, then click [OK] button. 
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The new user defined TMS Macro will be added in the TMS Macro table. User defined TMS macros can be 

modified and deleted in the list while the default TMS macros in the list is not allowed to be modified and 

deleted. 

 

  

 

User can edit the TMS Macro name by double-clicking the TMS macro in the table and entering the new 

TMS Macro in the field, then click [OK] button. 

To start mapping server macros to TMS macros, select a TMS Macro in the table. On the left panel of the 

window, select server macros that correspond to the selected TMS macro for each of the servers in the list. 

 

   

 

User can assign Parameters to server macros by clicking [...] button beside the Parameter column of the 

respective server. The Macro Parameter window will be displayed. Enter the parameter value in the field, 

then click [OK] button. 
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Parameter set to the macro will be saved and displayed beside its respective server macro. 

 

 

 

Once all TMS macros are configured to the server macros, click [Apply Changes] button to save changes made. 
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8.25.  Show Attributes 

Show Attributes of the shows available in the POS can be retrieved by TMS. If there are attributes that does 

not match with the predefined attributes of TMS, it can be matched with the predefined attributes in TMS or 

created as a new attribute in TMS.  Predefined Attributes available in TMS are 3D, CC, DBOX, HFR, HI, 

HOH, SUB, and VI.  

 

 

 

Once TMS detects that there are attributes available in the POS that are not predefined in TMS, the 

[Unmatched Show Attribute (N)] button will be enabled to the user else this button will be disabled to the 

user. User can click this button to match the new attributes from the shows of POS with the predefined 

attributes in TMS or to create an entirely new attribute in TMS. 

To match the new attributes available in the shows of the POS, click [Unmatched Show Attribute (N)] 

button, Unmatched Show Attributes window will be displayed. 
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Select an unmatched show attribute in the list, then click [Match with...] button. The Attribute to Match 

window will be displayed, this allows user to create a New Attribute or match it with the predefined attributes 

available in TMS. 

 

 

To create a new attribue, tick [New Attribute] checkbox, then enter the Attribute Name. 
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Click [Match] button. The New Attribute will be listed in the Show Attribute list. 

  

 

User can also match the attribute with the predefined attributes available in TMS, tick  [Available 

Attributes] checkbox, then select a predefined attribute in the list. 

 

 

 

Click [Match] button. The attribute will be matched with the predefined attribute available in TMS. 
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Show Attributes will be listed retrieved and matched with the predefined Attributes in TMS is listed in the 

Show Attributes table in the left Panel of Show Attributes Window.  
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Show Attribute window also allows user to define whether the Attribute Names are for Screens or CPLs. 

User can click the  or  icons to define the Attribute Name. The  icon indicates that the Screen/CPL 

possess the server attribute while  icon indicates that it is not a screen/CPL attribute. 

Once all attributes are defined, click [Apply] button to save changes made. 

 

 

 

Note: Show Attribute only supports VISTA and  VISTA – China POS vendor in the current TMS version. 
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8.26.  Server Attribute 

Server Attribute allows user to define the server attributes of the screens registered in TMS. Server 

Attributes listed are the defined screen attributes set by the user in the Show Attribute window.  User can 

click the  or  icons to define server attribute of the screen. The  icon indicates that the screen 

possess the server attribute while  icon indicates that it does not have the server attribute. 

 

 

 

Once all server attributes are defined, click [Apply Changes] button to save changes made. 
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8.27.  Server Buffer Time 

Server buffer time configuration allows user to define a buffer time for POS scheduling for each of the 

screen registered in TMS. Server buffer time indicates the time interval between two POS schedules which 

is generated by the template system. If POS schedule exceeds the buffer time set for the server, it should 

not generate the succeeding schedule and its corresponding show playlist. The default server buffer time is 

3 minutes and the maximum time that the user can configure is 10 minutes. Buffer time format is in MM:SS. 

 

  

 

In the scenario above, Hall 1, 2 and 3 buffer time is set to 10 minutes, this means interval for POS 

schedules to be generated by template system should not be less than 10 minutes. Once all server buffer 

times are defined, click [Save] button to save changes made, then click [Done] to close the Server Buffer 

Time window. 
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8.28.  Content Email 

Content Email function enables automatic ingestion of KDMs and DCPs from an email source into the 

Theatre store. 

 

 

 

 

Once the required configuration has been done and connection to the email server has been setup, TMS 

will keep scanning the e-mail server at regular intervals for new incoming emails with DCPs and KDMs that 

are not yet available in TMS Theatre_Store. The DCPs and KDMs are then automatically ingested to the 

TMS Theatre_Store. 

The intervals to scan for new DCPs and KDM emails can be set to ‘15 minutes‘, ‘30 minutes‘ or ‘hourly‘ basis. 
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8.29.  Restrict Ingest 

 

The Restrict Ingest feature will restrict  the user to ingest content during cinema operating hours.  

When this feature is enabled, TMS will prompt for a password when user tries to ingest content during cinema 

operating hours. 

 

Please check with GDC for the default password for the restrict ingest feature. 
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8.30.  Auto PMA 

 

Using the Auto PMA feature, it is possible to automatically schedule the powering ON & powering OFF of 

devices which have been setup on the PMA-2000. Refer to Section 4. for details on how to add and map a PMA 

device to a screen. The following sub-sections will explain how to this can be achieved, by modification of the 

Auto-PMA Power-ON & Power-OFF scripts. 

 

8.30.1.  Installing Python on the TMS Machine 

 

In order to edit the Auto-PMA Power ON & Power OFF scripts, we need to install Python (Version 3.6.2 or 

higher) on the TMS machine. The installation file for Python can be downloaded from https://www.python.org/. 

Once downloaded, double click on the executable file to start the setup wizard. The installation path for Python 

3.6.2 needs to be set as shown below. 

 

 

 

 

 

 

 

https://www.python.org/
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8.30.2.  Editing the Auto-PMA scripts using Python 

 

In order to access the Auto-PMA feature, the PMA Power ON & Shutdown scripts need to be created & 

uploaded. Every movie theater has different devices or ways to power on/off the devices, hence these script 

files cannot be standardized. The script files must be created according to the theater’s actual requirements 
(please contact GDC for the script files). 

 

The PMA Power ON & Shutdown scripts can be divided into two categories: 

 

a. For normal screen server setup: 

• Hall-1-power-on.py - for powering on 

• Hall-1-shutdown.py - for shutdown 

 

b. For dual screen server setup: 

• Dual-Hall-1-power-on.py - for powering on 

• Dual-Hall-1-shutdown.py - for shutdown 

 

 

 

 

 

 

 

 

 

 

 

Note: These script files should be renamed as per the screen server.  

It is recommended that the script filename should not start with a number. 

 



8. PREFERENCES 

 
  

 

13th April 2022 -230- User Manual for Theatre Management System TMS-2000  

Document Version 4.3.1.02 

 

In order to edit these script files, right-click & open them using the Python editor IDLE as shown below. 

 

 

  

 

The default Power ON and Shutdown scripts for Auto PMA are saved under the path ‘C:\Program Files 

(x86)\GDC\TMS\Sample Scripts\auto-pma’. Save the edited scripts onto the drive with the film library in the 
TMS Server inside a folder named “Auto-PMA”. Follow the steps mentioned below to edit the Power ON/ 
Shutdown scripts: 

 

1. Configure the Auto PMA Power ON script: 

a) Edit the file name of the Power ON script: “Hall-*-power-on” (* represents the hall number); 
b) Set the Server UUID (check in the Server management interface), IP address and Server type. 

c) Set PMA type and IP address; 

d) To set the automation mode for ACS-2800, use “True” and set the IP address. If not used, disable with 

“False”. 
e) Set the projector type [if the projector model is CHRISTIE (S1, S2, S3),  

NEC (S1, S2) or SONY MSM 600] HAS_PROJECTOR must be set as “True”. Set the corresponding 

Projector model and IP address. Set as “False” for other projector models. 
f) To set auto start mode for DOLBY sound processor, set as “True” and set the model number and IP 

address. If not used, disable with “False”. 
 

2. Configure the Auto PMA Shutdown script: 

a) Edit the file name of the script: “Hall-*-shutdown” (* is the hall number); 
b) Set the Server UUID (check in the Server management interface), IP address and Server type. 

c) Set PMA type and IP address. 

d) To set the automation mode for ACS-2800, use “True” and set the IP address. If not used, disable with 

“False”; 
e) Set the projector type [if the projector model is CHRISTIE (S1, S2, S3),  

NEC (S1, S2), or SONY MSM 600] HAS_PROJECTOR must be set as “True”. Set the corresponding 
Projector model and IP address. Set as “False” for other projector models. 
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Description of the PMA script parameters are as follows: 

 

▪ Parameter Z_MINUTES = 5 * 60: means that the script will check if the shutdown conditions (For 

example: If the playback server has finished playback, if no transfers are in progress etc.) have been met 

every 5 minutes starting from the scheduled script execution time for a particular screen under 

Preferences → Auto PMA. 

▪ Parameter N = 3: means that the script will determine the shutdown conditions three times continuously. 

In the above example, the script will check if the shutdown conditions are met in intervals of 5 minutes. 

▪ Parameter T1 = 120: means that the script will determine if there are no scheduled shows within the next 

120 minutes every time the shutdown conditions are checked. 

▪ Parameter T2 = 60: means that the script will wait 60 seconds after IMB is powered down (IMB executes 

“power-off”) before powering off the projector. 
▪ Parameter T3 = 1 * 60: means that the script will wait 1 minute after projector has been  

▪ powered off. 

▪ Parameter LIFE_IN_SECONDS = 3600 * 6: means that the script will run for a total of 6 hours from the 

scheduled script execution time for a particular screen under Preferences → Auto PMA. If the shutdown 

conditions are not met after the initial checks defined by parameters ‘Z_MINUTES’ and ‘N’. 
 

The values mentioned against each of the above parameters, are only an example. These can be adjusted 

according to actual requirements at site. Please refer to the below examples of modified Power ON & 

Shutdown scripts respectively. Save these script files once the changes are made. 
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8.30.3.  Uploading Modified Auto-PMA Scripts  

 

The modified Power ON & Shutdown PMA scripts need to be uploaded within the Auto-PMA feature. Go to 

Tools → Preferences. Click on the Auto-PMA icon. 

 

 

 

Double-click on the particular screen. Enable the ‘Power On’ & ‘Power Off’ sections & use the Browse Script 

button to search & select the Power ON/ Power OFF script which were created in the previous step. Select the 

appropriate script file depending on the screen chosen.  

 

You can also set the time of the day when these scripts should be executed by either selecting the ‘Every day 

at’ option and mentioning the exact time OR by selecting the ‘minutes before the first/last show’ option & 
mentioning the number of minutes before the first show/after the last show, the Power On/Shutdown scripts 

should be executed. Once the scripts have been selected, click on OK button. Repeat the same for other 

screens as well. 
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8.31.  TMS Labs 

TMS Labs is a testing ground for new or experimental features that aren't quite ready for prime time. They may 
change or disappear at any time. 
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9.  TMS REMINDER 

 

TMS reminder provides information about TMS license and server's registered to it. A reminder will be prompted to 

the user if TMS license expiry date is less than 90 days. Alternatively, it can also be accessed from the Help → 

About reminder menu option. 
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10.  CHECK FOR UPDATES 

With the [Check for Updates] option from the Help menu, users can periodically check for latest TMS updates. 
 

 

 
 

 

If there are any new released versions of GDC TMS available, then the system will dowload and upgrade the TMS 

to the latest available released version. If there are no new versions available, then the system will display ‚‘You 

are up to date‘ message. 
 

 

 

 

The [Advance Setting] and [Channel] options can be used to download any specific version of GDC TMS that is 

not yet released but maybe required for specific customers or regions. For such cases, GDC will provide the 

specific channel name for downloading the TMS version. 
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11.  ADDITIONAL FEATURES 

11.1.  Amend CPL Metadata 

This feature allows users to modify the CPL Metadata. This feature can be used in cases where the CPL 

metadata information is missing or is set incorrectly. 

 

The option to amend the CPL Metadata is disabled by default.  The option can be enabled from Tools → 

Preferences → TMS Labs → Enable Amend CPL. 

 

 

 

To view or amend the CPL Meta data, navigate to the View → Template System → POS → Match Title screen.  

Select and right-click on the CPL and click on ‘View Metadata’ option. 
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The following screen will display the metadata of the selected CPL. User can accordingly modify the metadata 

and save the information.  

 

 

 

TMS will prompt with the following warning. Click [Yes] to save the metadata. 
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11.2.  TMS Macro with CPL Mapping 

 

TMS also allows the ability to set TMS Macro for individual CPLs within the template system. This allows users to 

map a macro from the list of available TMS macros, to a particular CPL. Once the macro is mapped to a 

particular CPL, it gets programmed automatically with the CPL whenever that CPL is programmed in a pack or 

mapped to a POS title within the template system. 

 

To use this feature, navigate to the View → Template System → POS → Match Title screen.  Select and right-

click on the CPL and click on ‘TMS Macro with CPL mapping’ option. 
 

 

 

Click on the ‘Add’ button in the subsequent screen. 
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Select the appropriate TMS Macro from the list of available macros in the ‘TMS Macro’ dropdown selection and 
set the entry point at which the macro should be executed in the CPL.  

 

 
 

Click the save button to complete the macro mapping process. The TMS macro is displayed alongside the CPL. 

 

 

 

Similarly, TMS Macros can also be mapped with CPLs using the Content and the Macro Pack tabs as well. 
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11.3.  Programming Intermission 2 

 

TMS also allows the option for programming a second Intermission. 

 

To enable this feature, navigate to Tools → Preferences → POS → Auto-SPL. Under Auto-SPL, check the 

‘Enable Intermission 2’ check box. 

 

 

 

 

Additionally, the ‘Intermission 2 template’ should also be enabled by setting it as a default template. 
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User can then program the Intermission 2 by following the same procedure as explained for the main intermission 

under Section 6.1.3.2.   

• User must enable the main intermission to be able to program a second intermission. Once the main 

intermission is enabled by checking the ‘Set Intermission’ check box, the ‘Set Intermission 2’ option is enabled. 
 

 

 

• Entry point of Intermission 2 should be greater than the Entry point of the main intermission. 

• Intermission 2 can only be programmed using the Template system and not using the manual method of 

SPL programming. 

• Intermission 2 is not supported using the Multipart content option. If Intermission 2 is required for features 

with multiple parts, then all the parts for that feature should be added during the POS title mapping similar 

to the process followed for single part features. 

• For multiple CPLs; duration of intermission’s entry point will consider the total duration of all CPLs mapped 
to the POS title. In cases where the entry point of the intermission falls on succeeding CPLs (example: 

CPL2….CPL n) and the rewind time assigned falls within the duration of the previous CPL (example: CPL 

1), then rewind cue point will be at the start (00:00:00) of the succeeding CPL. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



11. ADDITIONAL FEATURES 

 
  

 

13th April 2022 -244- User Manual for Theatre Management System TMS-2000  

Document Version 4.3.1.02 

 

11.4.  Programming Second Credits Offset 

 

TMS also allows programming a second credits offset. 

 

To enable the Second Credits Offset, navigate to Tools → Preferences → POS → Auto-SPL. Under Auto-SPL, 

check the ‘Enable Second Credits Offset’ check box 

 

 

 

Similar to the main Credits offset, a Second Credits Offset has been made available in the TMS Macro mapping section.  
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The default SECOND CREDITS TMS Macro is used by Template System as the Second credit cue that is 

placed in the credit offset section configured for the POS title when generating schedules and show playlist. 
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11.5.  Smart Macros 

 

A "SMART MACRO" when programmed in a pack, will automatically apply the right automation cues for sound 

and projector for the next CPL based on the CPL properties and the TMS Macro Mappings.  

The user does not need to program individual Sound and Projector macros if the SMART MACRO is used. 

 

For example: If a "SMART MACRO" is programmed in a macro pack before a Feature CPL, then the template 

system will check the format of the Feature CPL and will automatically match and insert the appropriate sound 

macros (for example: Sound 5.1 or Sound 7.1) and the projector macros (for example 2D Flat or 2D Scope), 

without having the user to add these macros individually. The process to use a SMART MACRO is the same to 

that of any other macro, which has been explained under Section 6.1.3.5.   

 

The following is an example of usage of SMART MACRO. 

 

 

 

The TMS then uses its intelligence to automatically insert the appropriate sound and projector macros based on 

the TMS Macro mapping. 
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The following is a typical playlist generated using a SMART MACRO. 
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